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1. Introduction

1.1 Basic information
Kovoprog is a device used for preparing programs for the numerically controlled machining tools, which
has a long-time tradition in the Czech Republic. The simplicity of handling and a very favourable
price/power ratio are two of its many virtues.
Version 4 is a Microsoft Windows-only application. It works on Windows 95 or higher and Windows NT 4.0
or higher.
The Kovoprog is developed by the Peska & Brtna Computer Service ltd. company, situated in Tabor,
Czech Republic. Please use the following contacts if you have any questions or remarks.

Adress:
Peska & Brtna Computer Service s.r.o.
Kotnovska 173
390 01 Tábor
Czech Republic
Phone:
+420 / 381 254 982
+420 / 381 256 757
Fax:
+420 / 381 254 781
+420 / 381 256 757
E-mail:
tech-support@kovoprog.cz
Website:
www.Kovoprog.cz

1.2 HW and SW configuration requirements
Minimum:
• Intel Pentium I processor - 166MHz or an AMD equivalent AMD
• 32 MB RAM
• Unshared graphic card with color depth of at least 16 bits
• At least 60MB of free disk space
• CD-ROM drive
• Windows 98
Recommended:
• Intel Pentium III processor - 800MHz and more, or an AMD equivalent (Athlon, Duron, etc.)
• 128 MB RAM
• Unshared graphic card with color depth of at least 16 bits
• At least 60MB of free disk space
• CD-ROM drive
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•

Windows 2000 or Windows XP

Warning:
Program works on MS Windows systems - Windows 98, Windows ME, Windows NT 4.0, Windows 2000
and Windows XP.
If you're experiencing problems with connecting printer to a parallel port occupied by the HW key, the
USB port HW key is also available.
To run multiple Kovoprog sessions on computers connected within a LAN, we offer you the network HW
key, which can be located on any computer in the network. Available in both parallel and USB variants.

1.3 Installation
To install Kovoprog on your system, run the SETUP program from the installation CD.
How to install:
1. Insert the CD to the drive. If it's available in on your Windows system, the SETUP program will start
automatically. Otherwise, run the SETUP.EXE in the root directory of the CD.
2. Following steps are described in the installation window which will guide you through the installation
process.
Notes:
The Hardware key supplied with the program requires appropriate Windows driver to be installed. The
SETUP program installs the driver automatically, but if there is a need to re-install the driver later, run
HINSTALL.EXE program which is located in the HINSTALL directory on the CD. It must be executed with
the -i parameter, for example d:\hinstall\hinstall -i
The installation of the program under the Windows NT, Windows 2000 or Windows XP
environment must be performed by the user with sufficient user rights!
The up-to-date drivers and Help versions can be downloaded from www.kovoprog.cz!
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2. Getting started

2.1 Work environment settings
The Kovoprog controls are similar as in other Windows applications. In cases the controls differ from the
usual conventions, it is well announced.

Program window includes standard elements:
•

•

•

•

Caption displays the name of the currently opened file. If the data hasn't been saved yet, the caption
will read "Unnamed". Also displays usual system controls: system menu and the minimalise /
maximalise / close program buttons.
Text menu is located (as usual) at the top of the window, under the caption bar. The menu items can
be accessed using keyboard or mouse. Press Alt to access the menu from keyboard, the first item will
highlight. Move through the menu with cursor keys, press Enter to open selected item, Esc to
abandon menu. The menu features may vary, according to the current program mode.
Toolbars include program's frequently used functions. The program has one main toolbar, that is
available anytime. Other program windows have their own toolbars that are displayed only when the
window is active. Also, the macro toolbar (simplifies macro usage in the process list) can be activated.
All toolbars are originally displayed in the "docked" status by one of the window's borders where they
do not cover the window's workspace. The toolbar can be dragged by the mouse and moved or closed
by clicking on the cross. It can be docked by any border or placed anywhere in the window.
Kovoprog toolbars usually cannot be docked by all window borders.
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•
•

•

Hold the Ctrl key pressed if you wish to place the toolbar next to the window border without being
docked.
You can switch between the flat and regular toolbar appearance using the environment parameters
settings dialog.
Status bar is located at the bottom of the window and displays some basic information. The short
help text (describes the function of the button the mouse cursor is on, menu item function, etc.) is
displayed in the left part. The right part displays Caps / Num / Scroll Lock signs and the installation
number (or the DEMO label, indicating that the program is running in the demo mode). The current
time is displayed at the very right

The tool and status bars can be hidden (or displayed) from the View menu. This function can also be
acessed from the menu which will open after clicking the right mouse button on the toolbar.
The particular semi-windows are placed on the desktop during work. These can be set to the
maximalised mode (when they occupy the entire desktop) or normal mode (they have own frame and
title, can be moved or re-sized, but only inside the desktop). The third option is a minimalised mode,
when the window is represented only by its icon on the desktop.
To switch between modes, press Ctrl + F6. The windows can be ordered automatically by various
allignments in the Window menu. Some semi-windows can be simply shown/hidden by the buttons in
the main toolbar.

Most important work windows:
• Process list panel
• 2D geometry window
• 3D geometry window
• Operation window
• Simulation window
• NC program window

2.2 Process list panel
The program's main control panel. Provides acess to all data required to create a machining process. This
panel is the only object that will be displayed, when the Kovoprog is started for the first time. It is also
the Kovoprog's most frequently used part.
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The panel has two modes:
1. Docked
The panel can be docked by the left or right border of the main
program window (see the work environment example). In this mode,
it has no caption, but only the drag seam at the top. Panel
automatically fits the vertical size of the main window, its horizontal
size can be changed by dragging the vertical border. The panel lies
apart from the desktop and therefore does not cover any of the work
windows.

2. Not docked
Drag the seam at the top of the panel and tear it off the border. The
panel will leave the docked mode and will be displayed as a regular
sub-window (see the picture). Its caption will be displayed and its size
can be changed by dragging any of the window's borders.In this
mode, the panel can be placed anywhere on the screen, even outside
the main window. To return the panel back to the docked mode, drag
it and move it next to the window borders and it will stick to it again.



Holding the Ctrl key when moving the window will deactivate



To turn the docked mode on/off, acess the menu by clicking the



To quickly show/hide the panel, click the

sticking to borders (and therefore switching to docked mode).

right mouse button on the panel.
button in the main

toolbar.

You can use the bookmarks at the bottom of the process list panel to
switch between process list sections:
• Geometry manager
• Technology manager
• Macros manager

2.2.1 Geometry manager
The geometry manager is used to set main geometric parameters, such as desktop size or material
height. It is also used to work with the machining planes. It's possible to add/remove planes, to change
their position and description. To switch to the geometric elements editor for this plane, double-click on
the plane name with the mouse or click on the
button.
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2.3 Technology manager
The technologic process manager's main function is to define the component machining process. The
process is made up of a sequence of tool lines and operations. These items are selected by the buttons in
the upper part of the panel. To place the item to the correct position in the process, use the mouse.

2.4 Macros manager
The macros manager is used for macros administration. It allows to build
libraries and edit the macros inside. It's also possible to search and view
unused macro libraries.
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2.5 2D geometry window
The window will be displayed after clicking the
the

or

buttons in the main toolbar,or after clicking

button in the geometry manager, if there is one of the planes selected in the manager.

The 2D geometry window is used for definition of a component shape in a plane. There can be a 2D
geometry window open for every plane. The geometric elements of this plane are created or modified in
this window. In addition, the elements of other parallel planes can also be displayed. These elements
cannot be modified, but these can be used for various constructions (for example, the construction of a
parallel line).

More detailed description of this window will follow in the Description chapter.
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2.6 3D geometry window
The window will be displayed after clicking the
button in the main toolbar, or after clicking the
button in the geometry manager, if the 3D item is selected in the manager.
The 3D geometry window is used for:
•
•

Geometric object definition in four-axial cutting with non-constant bevel.
Geometric construction of generally positioned planes for bevelled holes cutting (only after the
Generic planes update).

2.6.1 Spatial object
The Kovoprog program uses the spatial object term for the generic four-axial machining definition. It is
a spatial geometric element defined by two planar splines and a system of edges.
The splines can be either both closed or both open. The splines must be situated in two different parallel
planes.
The edges are lines, whose first point lies on the first spline and the second point on the second spline.
The system of edges must be full, so that there must be at least one edge coming out of every vertex of
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both contours. The ending points of the edges do not have to be just the spline vertextes. The number of
edges coming out of one vertex is not limited.
The edges must not cross. Edge crossing is a situation which occurs when the end of the wire moving
from one edge to another moves along the already finished trace in opposite direction.
When constructing the object, the program checks the edge crossings and will not allow to create
crossing edges. The program also checks whether the edge system is full (and if it's not, it won't allow
finishing creating the object). In the Auto mode, the program automatically fills the minimal number of
edges required for a full object.
Podrobněji se budeme tímto oknem zabývat v kapitole Popis.

2.7 Operation window
All technologic operations whose outcome is the wire motion are edited in the graphic window similar to
the 2D geometry edit window. Basic definitions specifying the tool traces are made grap graphically
using the mouse and keyboard. Most operations allow adjustment settings. The operation dialog is
used for this.

The tool traces which have been defined by an operation can be displayed immediately in twodimensional simulation. The simulation mode is set automatically after clicking on the simulation control
buttons on the lower toolbar.
More detailed description of this window will follow in the Description chapter.
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2.8 Simulation window
The tool traces simulation displays the wire motion as it was calculated by the program. The trace of the
wire's intersections with the main and the help planes are displayed (even if the motion was programmed
in other planes). The buttons in the lower part of the window are used to control the running of the
simulation and its speed. Viewport setting is done the same as in the 3D geometry window. The view can
be switched to the XY plane (to display the rulers) or rotated freely by mouse or slide bars. During the
simulation, the name of the item the simulated trace belongs to and the coordinates of the wire in the
main plane are displayed in the lower part of the window. Use the button in the upper toolbar to
show/hide the coordinates panel which displays current coordinates of the wire's end in the main and the
help planes.



If only the two-axial cutting is programmed (no help plane is specified), the simulation is displayed
in two-dimensional view only.

More detailed description of this window will follow in the Description chapter.
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3. Basic work techniques

3.1 Create a new process list
A new process list is openned:
•

Immediately after strating the program.

•

After clicking on New in the File menu.

•

After clicking on the

button in the main button panel.

Two most important steps:
•
•

Create the machined shape(s).
Create the technologic process.

Creating the shape should logically precede creating the technologic process. Practically, the only
limitation is that the shape must be created before it's used in the process list. Therefore, when creating
a more complex program (which contains a large number of operations), it's possible to create new
geometric shapes and add them to the process list alternately. Existing geometric shapes can be modified
in the geometric editor anytime. If the modified shapes are already included in the process list, the
changes automatically take effect in the process list and all tool traces are recalculated.

3.2 How to create workpiece shape
3.2.1 Create new shape
 Click the

button in the program's main toolbar.

or
 Select the Base plane option from the Window menu.
Program displays the desktop dimensions specification dialog.

Text cursor is located on the first line, so it's
possible to fill in the particular dimension and skip
to the next line using the Tab button. Dimensions
can also be specified using the small arrows next
to the edit fields. Press Enter or click on the OK
button to confirm settings.
Specified values will only be used to set the
geometry display magnitude. Additional changes
can be done in the geometry manager.
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Now, the 2D geometry will open. In most cases, the first step is to create the construction geometry.

3.2.2 Create construction geometry
Click the appropriate button in the construction geometry panel to draw an element. If the panel is not
visible at the momment, click the
in the main geomtery panel.
The following construction geometry was created using these elements:
 Line parallel to the horizontal axis in the distance of 0 (line #1) – the

button.

How to set the parallel line's distance:
Make sure that the
button, (which activates the
coordinates and numerical entries rounding) in the
window status panel is on. Then click on the
button
at the bottom of the window. The rounding setting
dialog will open. Now easily set the rounding value to 1
using the small up/down arrows, or type-in the value from keyboard. To confirm, click OK or press
Enter:
 line parallel with the vertical axis in the distance of 0 (line no. 2) – the

button.

 line parallel with the vertical axis in the distance of -5 (line no. 3).
 line parallel with the vertical axis in the distance of -45 (line no. 4)
 circle with the center in the intersection of lines no. 1 and 2 and the radius of 35 – the

button.

To place circle center to the intersection of lines:
• Make sure that the
button in the window status toolbar is on.
• Place the mouse cursor so that the desired intersection lies inside the square. The found
intersection will be marked by the cursor in the shape of skewed white cross.
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The created construction geometry will now be used to create the workpiece shape.
3.2.3 Create workpiece shape
Click the
button in the contour panel. If the panel is not visible, click the
button in the main
geometry panel first. Now the program is ready for the contour's first point to be specified.
button in the
 Place mouse cursor on intersection of lines no.1 and no.4 (make sure that the
window status panel is on) and click left mouse button. The first point of the contour is specified.
 Place mouse cursor on line no.1, to right from beginning of the contour. Small cross will mark the
position of cursor on line no.1. This marks that the contour can continue on line no.1 and program
draws a line from beginning to center of the cross. Click left mouse button to confirm.
 Now the program awaits setting the end of the contour part leading along line no.1, or selecting next
geometric element which intersects with line no.1 (that the line will continue along). Cursor changes
to
.
 Place mouse cursor cross on circle no.1 up and right of line 1 and circle 1 to set the contour to skip
from line 1 to circle 1 in their left intersection and continue clockwise along the circle. When placed
on the circle, mouse cursor changes to cross shape, which marks that an acceptable contour
continuation has been selected. The intersection of the line and the circle is highlighted. Click left
mouse button to confirm.
 Use the same process to define transition from circle 1 to line no.3. Mark the line under its
intersection with the circle and above the center of the circle (to choose transition from the upper
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intersection downwards).
 Use the same process to set transition from line 3 to line 1 rightwise.
 Now place the mouse cursor over the intersection of lines 1 and 2. The skewed cross-shaped cursor
signalises that the intersection has been found. Click left mouse button to add the selected
intersection to contour, which ends the section leading along line no.1.
 Place mouse cursor over the last specified point of the contour. Cursor gains the shape of a small
filled square. Click left mouse button to finish contour creation.
The result of the described operation should look like this:

Because our workpiece will have corner fillets, the next step is the selected shape's corner filleting
operation.

3.2.4 Create corner fillet
Click the
button in the modification toolbar. If this panel is not visible at the momment, click the
button in the main geometry toolbar first.
 Place mouse cursor at the created contour (cursor of a cross shape indicates the selection) and click
left mouse button. Contour will be highlighted by the specified color (red is set as default). Small
squares will display at contour's vertexes. This signalises the points available for corner fillet
operation to be applied.
 Place cursor at corner at the very left. Cursor of the
Click left mouse button.

shape signalises correct mouse placement.
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. Two of the contour's vertexes are about to be filleted by the same
 Cursor shape will change to
radius of 2. Click the Repeat button in the lower part of the window. Now use keyboard or mouse
(rounding is already set to 1) to set fillet radius of 2.
 Mark created contour again and confirm by mouse. Now the white square is only in two contour
vertexes. The button with label R=2 is in the lower part of the window. This button must be turned
on. Now select contour vertex on line no.1, right of the vertex we've modified in previous step. Click
left mouse button and the vertex will be immediately filleted by the radius of 2.
 Mark contour again. Turn the R=2 button off. Mark the only one non-filleted vertex, click the mouse
and set fillet radius of 3. Now, the created contour looks like:

The shape we've created is just a half of the workpiece. The other part is symmetric by the vertical axis.
It will be created by mirroring the existing shape.
3.2.5 Shape mirroring
 Click the

button in the contour toolbar.

 Place the mouse cursor over an existing contour (cursor marks the selection by the cross shape) and
click left mouse button.
 Now use the mouse to set the mirroring axis. Everytime the mouse cursor is placed over an existing
contour, program draws a mirrored contour preview. Place the cursor on the line no. 2 and click left
mouse button.
We have created two mirrored symetric contours:
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To create desired workpiece shape, connect the two shapes into one.

3.2.6 How to connect existing shapes
Existing contours can be connected to one resulting shape.
 Click the

button in the contour panel.

 Make sure that the

button in the window status panel is on.

 Turn off construction geometry by the

button in the window status panel.

 Place the mouse cursor on the ending point of the contour in the beginning of the coordinates. The
found contour ending point is signalised by the cursor changing to a small cross. Ending points of
both contours are located at this point. Move the cursor square so that its center is positioned left of
the cross, which marks the found point. After clicking the left mouse button, the left of both contours
will be highlighted.
 Now the program is ready to connect more vertexes to the left contour. Leave the cursor over the
beggining of coordinates. The program finds the ending point of the right contour and changes the
mouse cursor to a shape of small filled square. This signalises the option to connect the found
contour. Click the left mouse button to connect both contours into one shape:
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The workpiece shape in the base plane is finished, now let's proceed to creating the shape in the help
plane.
3.2.7 Create geometry in help plane
 Click the

button in program's main toolbar.

or
 Select the Help plane item from the Window
menu.
Program displays the material height setting dialog (so that the help plane position could be calculated)
Set requested (non-zero) value and press Enter or click OK.
Now, the help plane 2D geometry window will open on screen. Make sure that the
button in the
window status toolbar is on. Geometric elements created in the base plane in previous steps will be
visible.
The construction geometry and the component shape are constructed the same way as in the base plane.
button in the construction geometry toolbar. If this panel is not visible, click the
 Click the
button in the main geometry panel first.
 Place the mouse cursor on the line no. 1 and click left mouse button.
 Use mouse or keyboard to set the bevel angle of 5 degrees.
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The created line no. 5 will be parallel with line no. 1. The distance will be calculated so that the bevel
angle of 5 degrees will be included between the lines. If the material height will be changed later, the
distance between lines will be recalculated to preserve the bevel angle.

No more construction elements in
the help plane will be needed. We
can proceed to creating the shape
in the help plane.
3.2.8 Create shape in help
plane
The shape in the help plane is
created by the same sequence of
operations as the shape in the base
plane, but instead line no. 1, line
no.5 will be used. The result are
the two splines in base and help
planes:

Both shapes will now be used to create the object.
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3.2.9 Create object
Click the

button in the program's main toolbar.

or
Select the 3D geometry item from the Window menu.
Now the 3D geometry window will be displayed on screen. The object construction is done in this
window.

button in the object toolbar. If the panel is not visible, click the
button in the main
 Click the
3D geometry toolbar first. Now the program is ready to start creating the object.
 Place the mouse cursor on the contour no. 1. The selection is signalised by the contour's color
change. Click the left mouse button to confirm selection. The main object contour is set.
 Set the contour no. 3 as the secondary contour.
•
•

The primary contour does not have to be located in the base plane and the secondary contour
in the help plane.
The primary contour must always be the contour upon which it's easier to find the machining
points, for example the one lying outside both.

Now, the edges defining the object must be specified. In our case (the object defined by two unclosed
splines), the program requests setting the edge connecting the ending points of both contours first.
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 Place the mouse cursor on one of the ending points of the main contour (no. 1). The cursor will
change to cross shape. Confirm selection by left mouse button.
 Proceed the same to set the second ending point of the edge on the secondary contour (no. 3).
button in the object toolbar. The program will automatically set the rest of the edges
 Click the
required for the object to be specified correctly.
•
•

Automatically created edges are drawn by a dotted line so that they can be differed from the
user-created edges.

After the automatic edges have been set, it's still possible to add more edges. When a new edge
is set, program recalculates the automatic edges and performs eventual corrections.

 Click the

button in the object panel to finish creating the object.

The new object will be used to create the machining process.
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3.3 How to create the machining process
3.3.1 Create new technologic process
 Click on the TECH bookmark in the process list panel to activate the Technology manager.
 You may fill in a Description field in the upper part of the manager (for later better orientation).
•

This is an optional step

 Click on the arrow next to the Machine field to open the available postprocessors list. Select the
postprocessor for the specified machine and click the right mouse button.
•

The postprocessor can be specified later (but must be specified before generating the NC
program).

The process list manager, used to create the machining process, is located in the lower part of the
technology manager.
 Click the button in the technology manager toolbar. The process list manager will switch to insertion
mode. Place the mouse cursor to the process list manager frame. The cursor will have this shape:
. The tool parameters item will be inserted to process list after clicking the button. The parameters
specification dialog will open. If needed, adjust the wire diameter and click OK, or press the Enter
key.

 Click the button in the technology manager
toolbar and insert the four-axial contouring item.
The manager displays a green arrow which
marks the target of insertion. In our case, only
one placement is available - inside the first tool
definition:

The operation window will open after inserting the
item. It's used to edit the contouring operation.

3.3.2 How to edit contouring operation
According to the fact that the geometry we've created only contains one shape (the constructed object)
that can be used in the chosen operation (four-axial contouring), the program automatically uses this
object to create the contouring cut. Therefore, at the momment the edit operation window opens, the
operation is already partially finished:
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 Click the button in the operation panel. The wire approach to cut mode menu will appear on screen:
button to insert the perpendicular approach from distance. The cursor
 Click the
will change its shape to
and the approach shape will be displayed:

 Use the keyboard or mouse to set the approach length. Press the 6 key, then Enter.
 Create the perpendicular deproach from cut analogically. Click the button in the operation panel.
Select the
button in the deproach menu to choose the perpendicular deproach. Set the deproach
length the same as the length of approach.
 An arrow is displayed in the middle of the contour trace. This arrow determines the machining and
correction directions. Place the mouse cursor on the arrow, the cursor will change to . Then click
the left mouse button. Now place the cursor of the shape to the right from the arrow, which sets
the machining direction from left to right. At the same time, the vertical cursor position determines
three correction options:
•

position over the contour sets the correction to left

•

position on the contour sets the trace without correction
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•

position under the contour sets the correction to the right; this correction type collides with
the specified approach to cut (which is from the right) and therefore, the arrow will be
colored red, which marks the possible error.

 Place the mouse cursor to the left and up from the arrow and click the left mouse button. The cut
geometry is set.
 Now click the button in the lower part of the operation window. The editor will switch to the
simulation mode and start the continual simulation of the wire motion. Use the button to control the
simulation run.

button in the operation panel to return back to edit mode.
 Turn off the
Now the additional operation properties can be set using the contouring operation parameters dialog.
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3.3.3 Contouring operation parameters
 Click the

button in the operation panel. The parameters settings dialog will appear on the screen:

 Click on the Approach field in the M function section. Check the field
to enable the column for entering the function number. Place cursor in
the column and type in the wire put on function (for example: 63).
 Set the wire cut off function in the deproach column the same way.
button in the bottom part of the dialog. The changes
 Click the
that have been made will take effect in the graphic editor window:

• If you check the Auto field in the bottom part of the dialog, the delay
size column will be displayed instead of the button.

•

From now on, all changes will take effect in the editor window in a specified time interval.

We have the tool trace programmed, let's proceed to creating the NC program.
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3.4 How to create NC program
3.4.1 New NC program
Check if the machine (that the NC program will be generated for) is specified in the manager.
 Click the

button in program's main button panel.

or
 Select the NC Program option from the Window menu.
The NC program window will open and the NC program calculation procedure will start. The calculation
can be interrupted anytime using the Stop button (the NC program will not be finished!). After the
calculation is finished, the NC program can be viewed or modified in the editor window.

The generated program can be saved to a text file or sent directly to the output device.
3.4.2 NC program output
 Click this

button in the NC program toolbar

or
 Selected the NC Output option from the NC Program menu.
The transmission line parameters settings dialog will open. Adjust settings and click OK to start the
transmission.
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The information window included all important
facts is displayed during the transmission. Click on
Stop to interrupt the transmission.

3.5 How to write a new macro
3.5.1 New macro example makra
•

Start the Kovoprog system. The
process list panel will be displayed in
the left part of the main window.

•

Click the MAK bookmark at the
bottom of the process list to enter the
macros manager.

•

Click on the icon n
ext to the System item to display its contents. The library icons will be
displayed. Click on the GEOMACROS icon or the library name.

•

Click the
"New macro" button in the macros manager panel. The macros editor window will open
on the desktop. Use this window to write new macro.

•

A new toolbar will appear at the top of the manager:

.
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•

Now, we can start to write a new macro. We will create a cycloid surface macro.

•

When the macro is
finished, click the
button to compile macro. If
there are no syntax errors
in the macro, the "OK"
message will be displayed
in the status bar. In other
case, the error message
will be displayed. After
necessary corrections, click
the compile button again.

•

After compiling the macro
sucessfully ("OK" message)
click the
button to
save macro. The macro will
be saved to the
GEOMACROS library
(specified before) under
the “Cykl” filename. Set
the macro name and its
icon in the macro heading.
The macro will be
determined to be of
geometric type because it's
saved in the geometric macros library. Then it can be added to the process list in the geometry
manager.



Macros library properties are described in the Macros manager chapter in the System part.
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4. Program controls description

4.1 User environment
4.1.1 Main toolbar

Contains the program's most important functions:
Create new (empty) process list.
Open existing process list data from file.
Save file to disk. If it wasn't saved yet, the dialog for specifying the filename appears.
Call the printer output. Depending on the active window, prints either text (partprogram, macros,
NC program) or graphics (shape and technology editors).
Show (when on) and hide (when off) the process list panel.
Show (when on) and hide (when off) the editor of the component shape in the base plane. If the
window is already on screen, but is not visible, or is minimalised, it's restored by this button.
Does the same function as the previous button, but for the editor of the shape in the help plane.
Does the same function as the previous button, but for the component shape editor.
Show (when on) and hide (when off) the NC program window. If this window is already on
screen, but is inactive or minimalised, it's activated or restored by clicking this button.
Open the program help.
Start the context help mode. The mouse cursor changes and the program waits for the user to
specify the subject on the screen on which the help is required.
4.1.2 File menu
The File menu includes following file operations:
•

New - Create new turning/wire-cutting document.

•

Open... - Open an existing document.

•

Save - Save current document.

•

Save as... - Save current document under a new filename.

The Import and Export options are used for work with the CAD systems graphic data.
•
•

Import - Import DXF, IGS and IGES files, or a specialised Kovoprog geometry KPG file.
Export - Export geometry to the Kovoprog KPG format, or the DXF graphic format. DXF export is
available only when the workpiece geometry window is active.

Next three items of the menu are:
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•
•
•

Print settings - Activates the printing settings menu.
Print preview - Previews the printing output. The option is available only when the workpiece
geometry window is active.
Print - Opens the printing menu. The active window's contents are then printed from Kovoprog.

The File menu also includes a list of the nine recently openned files and the Exit function which
terminates the program.

4.1.3 Open file
The open file dialog can be activated by the button inn the main toolbar or by accessing the Open...
option in the File menu.

Open file dialog control elements:
Filename
Displays the name of the file we want to open. The filename can be also typed in.
Soubory typu:
Select the type of displayed files (PLD, KPG, PPR, or all files).
Popis:
The description (if it's filled) of the file will be displayed in the window on the side.
Verze:
Displays the Kovoprog version the file has been created with.
Stroj:
Displays the name of the machine / postprocessor the file has been created for.
Click Open to load the selected file. The Preview button turns on/off the 2d or 3D preview.
In the preview window, it's possible to choose displaying of the contours, construction geometry and
dimensions as in the geometry editor.
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4.1.4 Edit menu
The Edit menu includes 2D geometry mode
items - Construction geometry, Contours,
Dimensioning, Element modifications, Delete
element, Edit contour in technology mode
(KON etc.) - Approach, Deproach, Technologic
point, in NC window mode items exclude,
copy, insert etc. The items change according to
the currently opened window and are used for
example to create component geometry, create
contour, dimensioning and for particular element
modifications. The same items are included in the
toolbars - dimensioning, construction geometry
and contours, which are displayed to the right
from the geometry window.
4.1.5 View menu
The View menu features:
Main panel
Main geometry panel
Status bar
Calculator
Construction geometry panel
Contours panel
Dimensioning panel
Modifications panel
Off-level geometry
Construction geometry
Contours
Labels and numbering
Dimensioning
The menu is used to show/hide the enlisted features. The last five options correspond with the icons on
the desktop status settings panel.
4.1.6 Zoom menu
The Zoom menu is used to select the current displaying measure in the
workpiece geometry creation mode. To switch the measure, use the
menu, or the icons in toolbar.
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4.1.7 Settings menu
The Settings menu includes these items:
• Colors: Allows to define colors of the Kovoprog environment: base, geometry and edit.
• Parameters: This menu allows to edit displaying and printing parameters in Kovoprog. This includes
line widths, size of fonts, arrows and other
•
•

Language: Select Czech or English Kovoprog version. The language
selection will take effect in the next Kovoprog session.
Environment: This item allows to set environment parameters,
including environment appearance, toolbars and process list items
edit/display in own windows option.

The second item of the Environment menu is the process list automatic
back up settings option. Set the backup interval and number of history files.
The last item, Various contains number of most frequently used files setting and turn on/off
displaying favorite items in open file dialog.

Color settings
The color settings dialog is located in the Settings > Colors… in all geometric windows, except the
import window which has a special color settings button.

The geometric windows color settings
dialog has three bookmarks – Base,
Geometry and Edit. You can arbitrarily
switch between these bookmarks. The
objects whose settings can be changed are
sorted under these bookmarks. It's
possible to change the following
properties:
Color (for every object)
Click the field with the currently specified
color of the object to open the standard
Windows color settings dialog.
After selecting a new color, the color of
the field will change to this color.
Style (for some objects only)
line type - the field displays the currently
selected line type including the current color combination. After clicking on the arrow, you can choose
from the pre-defined styles. The last line style is the empty style. The object with this line style selected
will not be displayed.
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transparency - Drag the slide bar with a mouse to set the object transparency. The position to the very
left means an invisible object. Position to the right means a solid object.
OK
Close the dialog and accept changes.
Cancel Close the dialog with no changes.
Apply
The changes will take effect on desktop, without the dialog being closed.
Change all colors to default values. This change must be confirmed once more by the user.
Default
Then the dialog is closed.
Parameters settings
The color settings dialog can be
reached from the Settings >
Parameters… menu.
It's used to set the parameters of
printing, dimensioning and displaying.
Printing parameters
Dimensioning parameters
Displaying parameters
Mouse cursor parameters
Printing parameters
The print parameters settings are
located bookmark of the Parameters dialog which can be reached from the Settings > Parameters …
menu.
This dialog allows to specify the line width for geometry printing.
Thin full line width
Defines the width of the printed thin full line in milimeters. This line type
represents an element which is not a contour nor an object. The specified line
width can be from interval from 0 to 5 milimeters. When a zero width is set, the
printed line width will be of one printer unit.
Thick full line width
Defines the width of the printed thick full line in milimeters. This line type
represents an element which is not a contour nor an object. The specified line
width can be from interval from 0 to 5 milimeters. When a zero width is set, the
printed line width will be of one printer unit.

Dimensioning parameters
Dimensioning parameters are specified in
the Settings > Parameters... menu under
the Dimensioning bookmark. The dimension
display options can be set in this dialog. The
values in this dialog affect all dimensions
and also the printed output.
Dialog allows to choose the way the
dimensions are displayed. The settings in
this dialog affect all existing dimension and
affects both displaying on the screen and
the printing output.
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Font size
Defines the absolute dimension label size in milimeters.
Arrow size Defines the absolute arrow size in milimeters.
Overlap
Defines the absolute overlap size of the lead line above the dimensioning line in milimeters.
size
Length
accuracy
Angle
accuracy

Defines maximal number of displayed decimal places of the length dimension (when using
implicit format).
Defines maximal number of displayed decimal places of the angle dimension (when using
implicit format).
Every single dimension's display accuracy (number of decimal places) can be set in its
formatting string

Display parameters
The display parameters settings are located
bookmark of the Parameters dialog which can
be reached from the Settings > Parameters
… menu.

The dialog allows to set the angle displaying
format.
30°30'30"
30,55°

check this field for the degrees - minutes - seconds format.
check this field for the degrees decimal number format.

Mouse cursor parameters
The mouse cursor parameters settings are
located bookmark of the Parameters dialog which
can be reached from the Settings > Parameters
… menu.
The dialog allows to specify the cursor size and
coordinates rounding amount.

Cursor size

Rounding

Defines the size of the displayed square of the mouse cursor in pixels. The size
of this square is also the interval in which the mouse cursor snaps to geometric
elements.
Defines the amount of the coordinates rounding for the cursor motion in both
axes and when setting distance. Rounding is only done when the snapping to
geometric grid option in the desktop status toolbar is on.
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Work environment settings
The environment setting option is located in the Settings > Environment... menu.
The settings dialog has two bookmarks:
Environment settings

Buttons appearance setting:
Flat button
appearance
(default)
Classic button
appearance
Button appearance changes will take effect in the next Kovoprog session.
Process list items edit/simulation windows openning:
windows will open with inactive fixing button
windows will open with active fixing button
Fixing button
The edit operation and simulation window panels contain the
fixing button. This button sets the
relationship between the window and the technologic process manager:
the button is off
:
the window is being continually synchronized with the technology manager. The window allows to edit
the operation on the selected line of the manager (or displays the simulation of the selected line). If the
selected line is not a part of the operation, the edit operation window content will not change.
the button is on
:
the window is locked and its contents remain unchanged, regardless of the selected manager line. This
provides a possibility to display simulation and edit multiple process lines at once.
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Automatic backup
Automatic backup helps to precede the unfortunate loss
of data which can occur when the program is improperly
terminated. This can happen as a result of, for example,
the power failure or a software error on the computer
where the program is running. The automatic backup
function is set using the environment parameters settings
dialog.
If the Backup automatically option checked, the
program will be automatically saving data in the specified
period. The data are not saved in the original file, whose
name is displayed in the program title. This file remains
in its original state and is overwritten only in the case the
user saves the data manually, using the Save function.
The file backup is stored in the new file. In the case of
improper program termination, the backup file will remain
on the disk and the next time the program is started, the
user will be asked if he wants to reload the backup file
content. The backup file will be emptied and ready for
next use.
The miscellaneous menu is located under the third
bookmark.

4.1.8 Window menu
The Window menu is used to switch between particular
Kovoprog windows such as Process list, Geometrie
Semiproduct-workpiece geometry, Geometry in planes,
History - it's possible to return to the saved files history, NC
program, Generator (if available).
Also, the menu includes items used to organize displaying
of Kovoprog windows. These items are useful for better
orientation during working. Kovoprog arranges windows
next to each other (horizontally) or under each other
(vertically). The icons can also be arranged.
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4.2 Create workpiece geometry
4.2.1 Geometry manager
Located in the process list panel under the GEO bookmark.
Description - This field is used to fill in a short description, which
will be displayed in the open file dialog. This simplifies the
navigation in a large amount of data.
The
button opens the description edit window, when more
than one line description is required. Multiple lines description is
used by some NC program input postprocessors.
Machine - This field is used to specify the machine the NC program
will be compiled for. The machine is selected from the list which
appears after clicking on the field.
If there is only one postprocessor in the installation, the field is filled
in automatically.
The
button opens the postprocessor configuration parameters
dialog. These parameters influence the NC program creation
process. The number and the type of the parameters depend on the
seected post processor. However, some post processors do not
support this function.
The postprocessor function is influenced by
configuration parameters' values. Quantity and type of
parameters depend on the machine type. Program
offers default values, set during program installation.
Use the Save values button to save most frequently
used parameter values. This set of parameters will
always be loaded after clicking the Load values
button. It's always possible to load default values by
clicking on Reset.

Material height - The material height must be specified for the case of a four-axial cut, or when it's
required by the postprocessor. Otherwise, the value can be left zero.
To allow creation of a four-axial cutting program, it's required to specify a non-zero material height. Click
in a column, which will then highlight, and specify the value.



A non-zero material height must also be specified in a case the two-axial cut is programmed, but
(for any reason) we want the simulation to be displayed in 3D view.

The material height is closely related to the positions of base and help planes when programming a fouraxial cut. If we want the help level to be positioned on the bottom face of the material, a
negative material height must be specified!
Geometric planes
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The planes are very important for the conception of the workpiece's geometric properties description. The
base of the (2-axial or 4-axial) machining traces description are the planar splines (because also the
definition of a spatial object is based on planar splines). The Splines (called "contours" in the program)
and also other two-dimensional geometric objects (the construction geometry) are distinctively connected
with the plane they're located in (and in which they were created).
In the Wire cutting variant, Kovoprog works mostly with the planes parallel to the X and Y axes. Every
such plane is distinctively defined by its Z coordinate. The program automatically administers two most
important planes:
•

Base plane is always defined and cannot be deleted. In most occasions, it's the plane where
the bottom face of the machined material is situated. Its position is automatically set to Z=0, but
can be adjusted by the user.

•

Help plane is automatically created at the momment the user specifies a non-zero heigh of
the material and it also cannot be deleted. Usually it's the plane where the top face of the
machined material is situated. Its coordinates is always equal to the sum of the Z coordinate and
the material height. If the user changes the height, the position of the help plane changes
automatically, and vice versa. If the material height is a negative number, the help plane is
located under the base plane.

In some cases (cutting facets or bevelled holes), it's not possible to work with just one or two planes. The
program can work with any number of planes. The planes parallel to the base plane are called reference
planes. The number of reference planes is not limited, any Z can be specified for them and they can be
of any name. The reference planes can the be deleted, but only when they do not contain any geometric
elements.
The general planes program upgrade (for an additional charge) brings the option to insert the planes
which are not parallel with the base plane to the process list. Such planes are used for bevelled holes.
There are two ways to create general planes:
•

the plane defined by its trace (intersection with the XY plane in Z=0) and by its bias (angle
included with the XY plane) can be created using the
button in the geometry manager.

•

3D geometry editor allows to create geometric planes defined by the help construction geometry.
These planes are also displayed in the geometry manager, where their name can be changed.
Their geometric properties can only be modified from the 3D editor.

The 2D graphic editor window can be openned separately for every plane. The planar geometric elements
can be created, modified or deleted in this editor. All elements are situated in the plane belonging to the
editor window. The displaying of the elements situated in other planes can be allowed or disabled in the
editor. Elements of other parallel planes can be used as related elements (for example, create parallels to
them, use their intersections...), but cannot be modified or deleted.
When calculating machining traces, all tool motion coordinates are recalculated to the base and help
planes, even in the case the splines define the cut in the reference plane with different Z coordinate or in
the bevelled plane.
All manipulations with planes are done using the geometry manager.
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Desktop size - The desktop size is used for displaying of graphic data. It's displayed in the graphic
windows as desktop borders. They're also used when changing the zoom by the
button or from the
Zoom > All menu.



In some postprocessors, these values are

transferred to NC program.
The dimensions must be set so that:
Xmin is lesser than Xmax
Ymin is lesser than Ymax
Click on the first column we want to fill, which places the edit cursor in it. When filled, press Enter. If the
above-mentioned condition, cursor moves to the closest next column that needs to be filled in, otherwise
it remains in the same column (because the value has not been specified correctly).
The geometric planes manager is located in the lower part of the GEO bookmark.
Planes manager buttons
Add plane a parellel with the base plane - a so called reference plane. The reference plane
settings dialog will appear after clicking this button. It differs from base and help plane settings
because also the name of the plane can be specified.
This dialog is used to:
•

•

Specify the reference plane's name. The
name is useful for better orientation in the
planes manager.
Specify the position of the reference plane
parallel with the base plane. The position
is defined by the Z coordinate value.

Add bevelled plane. The generic plane settings dialog will appear after clicking this button.
This function is included in the Generic planes program upgrade.
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This dialog is used to:
•

specify the position of a generic plane. The position is defined by the intersection with the
plane parallel with the X and Y axes, for Z=0 (i.e. the trace) and by the plane slope angle
(i.e. bias).

•

specify the name of a generic plane. The name of the plane is practically only useful for
better orientation in the planes manager.

The trace is defined by the angle (in degrees) it includes with the positive direction of the X axis and by
its distance from the beginning of coordinates (the X=0, Y=0 coordinates point in the Z=0 plane).
The bias defines the plane slope in degrees.
When it's necessary to define this plane's position exactly, in relation to the geometric elements in other
planes, it's required to construct this plane using the 3D editor features
Specify the name and position of a generic plane. The position is defined by the intersection
with the plane parallel with the X and Y axes, for Z=0 (i.e. the trace) and by the plane slope
angle (i.e. bias).
Remove selected plane from manager. Base and help planes cannot be removed. Nor can be the
plane containing any geometric elements.



Before deleting reference or generic plane, it's necessary to remove all of its geometric
elements first. To do this, use the 2D editor.

Edit selected plane. Opens the graphic 2D editor window of the selected plane.



The editor window can be openned by double-clicking on the plane line.

All functions of the planes manager are also available through context menu activated by right-clicking in
planes manager.
4.2.2 Geometry windows
There are two types of geometric windows in Kovoprog. 2D geometry windows are used to create flat
components. Spatial objects are created in 3D geometry windows. There can be multiple 2D geometry
windows (for different planes) open at a time, always only one 3D geometry window is allowed.
The status bar at the bottom of the window is a common part of all geometric windows. It displays the
action that is expected from the user.
The Description button is located in the right part of the status bar. If it's pressed, the edit field is
displayed next to it, which is used to set the geometric elements description. The construction geometry
elements can also be numbered (two elements of the same type can not share the same number). The
next unassigned number can be assigned to the selected element by clicking the arrow next to the
description edit field. When specified wrong, or when automatic numbering is on (see the desktop
settings panel), the first unassigned number will be inserted to the description field. Unlike the

Kovoprog – Wire cutting – User's guide - page 41

construction geometry, contours and objects can have text description which can be shared by multiple
objects.
Next to right, coordinate axis descriptions follow, displaying the current coordinates. Click the right mouse
button on the axis description button to open the related menu with three options. The first option turns
on/off the Coordinates rounding. The Accuracy settings option is used to set the rounding amount
and the third option is the Cursor size setting.
The

button is located to left above the status bar. This button is used to redraw the desktop. The

desktop status settings panel is located in the upper part of the window. The main geometry panel is also
displayed with the window, which is used to switch between the edit mode and the toolbar functions.
Clicking the right mouse button on the desktop, a small menu with three options will open:
Back returns the element on modification step back, or returns the finished edit opration to its original
state.
Edit selects the element the mouse cursor is placed on for modifications.
Cancel deletes the element the mouse cursor is placed on.
The import window is a special 2D geometry window which is used for import of the DXF or IGES format
data. It has a slightly different attributes, because of its function.
•
•
•

Coordinates rounding can be activated from the desktop settings panel.
Rounding amount settings dialog can be activated by clicking on the axis description button with the
left mouse button.
All toolbar function can also be found in the main menu.

4.2.3 2D geometry window
Whenever we want to set
shape cutting (either planar
or bevelled), the first
condition is to create a
planar spline (contour) that
describes the shape of the
cut. The 2D geometry
window is used for this task.
Planar splines are created by
the spline creation tools.
Lines, circles and Bezier
splines are added to create
the contour. When
constructing more complex
shapes, it's good to have the
help construction geometry
lines constructed first and
then use these to define the
contour. The existing
contours can be slided,
rotated, mirrored, and their
equidistants can be created.
Particular separate contours
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can be connected into one. Some special contour shapes, such as rectangles, circles or regular polygons
can be created directly by a function in the toolbar.
The contours can also be imported from DXF or IGES type files.
The window works in four basic modes. To switch between modes, use the toolbar
, located next to the program's main toolbar:
•

Construction geometry mode – create help geometric elements (lines, circles, points) that can then
be used to construct a spline. In this mode, the functions of the geometry toolbar are available.
Spline (contour) construction mode. Uses functions of the contours panel.
Modifications mode – allows to modify existing geometric elements (both construction lines and
contours). The program maintains mutual relations between elements as they were created, it means
that perpendiculars remain perpendiculars, parallels remain parallels etc. The functions of this mode
are located on the modifications panel.
Dimensioning mode – allows to add dimensions to the drawing. Dimensions are associative and when
the element changes, dimension text also changes automatically. Dimension types are selected from
the dimensioning panel.

•
•

•

The toolbar which allows quick access to all frequently used settings of the graphic editor (such as
coordinates system type, mouse cursor modes and visualisations of the drawing) is located in
the upper part of the window.
The most part of the window is occupied by the desktop. The measure is displayed at the left and
bottom. The guideline marking the cursor position is diasplayed on the left and bottom measures.
The

button in the lower left corner redraws the desktop. This is useful for example after deleting an

element.
The important part is the status bar at the bottom of the window. It offers following function (from left
to right):
•
•
•

•

Description of the current work mode - a short indication of what is currently expected of the
user
Description column allows to add description to particular contours, construction elements can be
marked by numbers. To hide/show this column, click the Description button.
Numeric values edit columns. Number and description depends on the current particular entry.
Moving the mouse cursor when setting the entry will cause the mouse cursor coordinates to be
processed and displayed in the edit columns. Use the mouse or press any number key to move cursor
to the edit column, where it's possible to type in the entry from keyboard. In this case, the specified
value takes effect on the desktop, where it's processed to an immediate result. Therefore, the user
has the visual control of the specified variable.
If the specfied value is two-dimensional (for example the coordinates of a point), there are two
columns displayed. After setting the value in the first column (for example the X coordinate), press
Enter to move edit cursor to the second column. Pressing Enter again will eventually proceed to the
following entries.
Edit column description buttons
Click this button to open the reunding settings dialog for the current value. Click the right mouse
button to open the context menu where it's possible to turn rounding on/off, set rounding amount and
set the mouse cursor size.
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Repeat
button
Setting some scalar values (for example circle radiuses) offers the tool for setting the same value
multiple times.
•

The Repeat button is displayed at the very right of the status bar
during the setting of the variable. Press the button to remember the
ending value of the currently entered variable.
Before setting the remembered variable, the button displaying the
remembered value will be displayed on the status bar. If the button is
pressed, the value is used directly. A construction of multiple circles of
the same radius can be done this way.
The arrow to the right from the repeat button displays the menu in
which the recently remembered values are displayed. Here it's possible
to choose a value different to the one displayed on the button. This
selected value will then be displayed on the button and used as
mentioned above.
The Apply to all points item offered in the menu is used in the case we
want to apply corner fillet or cutoff on all vertexes of the selected
contour.
The number and labels of the axis description buttons change according to the edit mode. When setting a
point or a displacement amount, there are two buttons displayed. When setting length, angle or count,
there is only one button displayed and when selecting an element, no button is displayed. The currently
entered value is always displayed on the status bar, next to the axis description. This value can also be
changed from keyboard by switching to the edit column by mouse, or just by entering the value. Press
enter to confirm the specified value. To switch between edit columns, press Tab, , (comma) , or ;
(semicolon).
To speed up the work when setting repeating elements of the same type, use the Repeat button. It's
only visible when setting lenght, angle or count at right part of the status bar. For example, click this
button before setting the radius of a circle. When the radius is set, the text on the button will change to
the value of the remembered radius. When drawing the next circle, Kovoprog does not request setting
the radius again and creates a circle of the same radius as the previous one. To set a different radius,
simply turn the Repeat button off.
To simplify the work when setting repeating elements of the same type, use the Repeat button. It's only
visible when setting lenght, angle or count at right part of the status bar. For example, click this button
before setting the radius of a circle. When the radius is set, the text on the button will change to the
value of the remembered radius. When drawing the next circle, Kovoprog does not request setting the
radius again and creates a circle of the same radius as the previous one. To set a different radius, simply
turn the Repeat button off.
•
•

Using the Import and Export functions in the File menu, the 2D geometry window allows the DXF
and IGES format files import and DXF format export.
The 2D geometry window includes context help. Leave the cursor motionless on any geometric
element and the yellow frame containing information about the element will appear.
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Main 2D geometry window panel
Sets the 2D geometry window edit mode
Activate the construction geometry input mode, one of the functions from the geometry toolbar.
If the toolbar is not visible at the momment, it will appear on the desktop after clicking this
button.
Activate the contours input mode, one of the functions from the contours toolbar. If the toolbar
is not visible at the momment, it will appear on the desktop after clicking this button.
Activate the dimensions input mode, one of the functions from the dimensioning toolbar. If the
toolbaris not visible at the momment, it will appear on the desktop after clicking this button.
Activates the changes mode, one of the functions from the modifications toolbar. If the toolbar is
not visible at the momment, it will appear on the desktop after clicking this button.
Turn on/off the coordinates beginning input mode.
Turn on/off the desktop section zoom in.
Zoom out.
Set original zoom.

4.2.4 2D geometry window status toolbar
2D geometry window status settings.
Turn on/off coordinate beginning setting mode.
Switch to carthesian coordinates system.
Switch to polar coordinates system.
Turn on/off cursor snapping to the construction geometry element intersections.
Turn on/off cursor snapping to the construction geometry circle centers.
Turn on/off cursor snapping to the contour vertexes.
Turn on/off coordinates rounding.
Show/hide automatic element numbering.
Show/hide geometry in parallel levels.
Show/hide construction geometry.
Show/hide contours.
Show/hide objects.
Show/hide labels and numbering.
Show/hide dimensioning in the work level.
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4.2.5 Construction geometry toolbar
Contains construction geometry element creation functions. The same functions can be
found in the Edit > Construction geometry menu.
Construct a line specified by two points, or tangential to a circle. Program awaits
setting two diverse points or tangent circles or one point and one tangential circle.
Construct line through a point, or tangential to a circle including a specified angle
with the X axis. Program awaits setting the point or the tangential circle and then
the angle include with the X axis. To create multiple lines of the same angle, use
the Repeat button (must be pressed before specifying the angle).
Construct a line parallel to another line in a specified distance. Program awaits
setting the line that the new line will be parallel with and then the distance between
lines. To construct multiple parallels of the same distance, use the Repeat button.
Construct a line through a specified point on a circle or tangential to a circleand
parallel to another line. The program awaits setting the line that the new line will be
parallel with and then the point that the line will be led through or the circle it will
be tangential to.
Construct a line tangential to another line and led through a certain point or
tangential to a circle. Program awaits setting the line that the new line will be
tangential to and the point it will be led through, or the circle it will be tangential to.
Order of settings is arbitrary.
Construct a line including a specified angle with another line and led through a
certain point or tangential to a circle. Program awaits setting the line the new line
will be including the specified angle and the point it will led through or the circle it
will be tangential to. Order of settings is arbitrary. Then the angle the lines will be
including must be specified. Use the Repeat button to create multiple lines
including the same angle to another line.
Construct a line which is a axis of two elements. The program awaits setting two
elements of the same type - two points, lines or two circles.
Construction of a line parallel to the horizontal axis. Program awaits setting the
distance from the X axis.
Construction of a line parallel to the vertical axis. Program awaits setting the
distance from the Y axis.
Construct a line parallel to another line with a specified bevel angle. First, the
program awaits setting the line that the new line will be parallel with. This line must
be located in a differentr XY plane than the new line. Then the bevel angle must be
set. When constructing multiple parallel lines with the same bevel angle, the
Repeat button can be used.
Construct a point. Program awaits setting the point position.
Construct points on a line. Program awaits setting the first and the last point's
position and then the number of points. To create the same number of points on a
line, use the Repeat button.
Construct points on a circle. Program awaits setting the position of the center and
the circle radius or selecting an existing circle. Then the angle of the first point and
the number of points needs to be set. When creating multiple point groups of this
type, use the Repeat button to remember the circle radius and/or first point
position and/or number of points.
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Construct points on a circular arc. Program awaits the same entries as in the
previous case, but in addition, after the first point position also then the last point
must specified.
Construct grid of points. Program awaits these entries sequentially: first grid's point
position, point spacing in both directions and the point sequence. Use the Repeat
button to remember the number of points in any direction.
Construct circle specified by its center and radius. Program awaits setting the
position of the center, then the circle radius. If existing circle is selected when
specifying the circle position (the
snap to circle centers button in the 2D
geometry window status bar must not be on), the new circle will be concentric with
the specified circle. If so, the second specified value is not the radius but the
difference of radiuses. Use the Repeat button to create multiple circles of the same
diameter.
Construct a circle specified by the center and tangential element. Program awaits
setting the position of circle center and the point the circle will lead through, or the
line or circle it will be tangential to.
Construct circle specified by two elements and a radius. Program awaits setting the
position of two points the circle will lead through or lines or circles it will be
tangential to. Then the circle radius needs to be specified. Use the Repeat button
to create multiple circles of the same diameter.
Construct circle specified by three elements. Program awaits setting position of the
points the circle will lead through or the lines or circles it will be tangential to.
Construction of a circle with a specified bevel angle. First, the program awaits
specifying the basic circle, which must be located in a different XY plane than the
new circle. Then the bevel angle must be specified. To construct multiple circles of
the same bevel angle, use the Repeat button.
Construction of a line inferred from a contour. Program awaits setting the contour
or its part by the mouse. This function is useful for import of contours, when
additional contour modifications are required.
Construct a point inferred from a contour. Program awaits setting a contour or its
part. This function is very useful after new contours have been imported and
additional geometry modifications are required (for example to create a new
construction geometry point).
Construction of a circle inferred from a contour. Program awaits setting the contour
or its part by the mouse. This function is useful for import of contours, when
additional contour modifications are required.
4.2.6 Contours toolbar
Contains contour creation functions. The same functions can
be found in the Edit > Contours menu.
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Construct a contour specified by its ending points. Program awaits setting the ending points'
position. Contours based on construction geometry can be created in this mode - after the
contour's first point is set, new points can be added just by clicking on the particular construction
geometry elements, which the contour should copy (lines and circles).
Construct contour line tangent to the previous element. Program waits setting only the line
length. If it's the contour's first line (it has no previous element), it's also required to specify the
starting point. The direction is given in the positive meaning of the X axis. To create multiple
lines of the same length, use the Repeat button.
Construct contour arc tangent to the previous element. Program awaits setting only the arc's
ending point position. If it's the contour's first point (it has no previous element), it's also
required to specify the starting point. The direction is given in the positive meaning of the X axis.
Construct contour arc of a specified radius. Program awaits setting the arc's ending point position
and then its radius. To create multiple contour arcs of the same radius, use the Repeat button.
Construct contour arc of a specified central angle. Program awaits setting the position of the
ending point and then the central angle. To create multiple contour arcs of the same central
angle, use the Repeat button.
Construct bezier spline contour element. Program awaits setting the ending point of the spline
and then the direction and value of the ending tangential vector. The spline's starting tangential
vector has the same value as the ending tangential vector of the previous element, but opposite
direction. If it's the first point of the contour (there is no previous element), also the position of
the starting point must be specified. The starting tangential vector has the direction in the
positive meaning of the X axis, and the size of one (which can be modified).
All previous contour creation functions allow to create contours of any shape. It's possible to switch
between them anytime. The contour creation process ends by clicking on any of the contour's ending
points. Clicking on the last specified point, the contour will remain open, clicking on the first point the
contour will be closed. If the cursor snapping to the contour ending points function is on, it's possible to
join the current contour to an existing one. Two separate open contours can be joined this way.
Construct a rectangle shaped contour. Program awaits setting the first point of the rectangle and
then its size.
Construct a circle shaped contour. Program awaits setting the position of the center or the
construction geometry concentric circle and then the radius size. If the concentric circle has been
specified, not the radius, but the difference of radiuses will be specified. Use the Repeat button
to create multiple circle contours of the same radius.
Construct polygon shaped contour. Similar to the previous function, program awaits setting
center and radius, or concentric circle and difference of radiuses. Then the number of vertexes
and the rotation angle of the first one must be specified. To remember the radius and/or the
number of points and/or rotation angle, use the Repeat button.
Last four functions create regular closed contours.
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Construct text shape
contour. Program
awaits setting the
contour position. The
lower right corner of
the text is about to be
specified. After that,
the text, font and size
settings dialog will
open. The result is a
sequence of lines
defining the text
contour. Use this
function in the
modifcations toolbar to
change existing text
contour properties.
Using this
function in the
modification panel to
transform the
sequence of lines into
particular elementary
contours.
Insert macro-constructed contour to geometry window. After clicking the button, the macro
libraries panel will open. See the macros manager to learn how to create and operate macro
libraries.
Represents the "Analytic splines" library. Contains these
macros:
Archimedean spiral, ellipse, evolvent and bevelled hole
ellipse. The library is supplied along with the system.
Libraries
panel

Represents the ”Gear wheels geometry” library.
Includes the gear wheel, gear wheel across sprockets,
gear wheel across rollers, inner gear wheel, inner gear
wheel across rollers macros.
This library is delivered with the system.
The icon represents libraries created by the user. See the
macros manager to learn how to create and operate macro
libraries.

When the library and the macro are set by clicking on the library/macro icon, the program awaits
setting the macro parameters in the table, which will appear on the desktop. Set the requested
parameters to create the contour. The result will be displayed in the geometry window.
Construct displaced contour. Program awaits setting source contour and displacement amount.
Construct rotated contour. Program awaits setting source contour first, and next the rotation
center position and rotation angle. To create multiple contours this way, use the Repeat button
to remember rotation angle size.
Construct mirrored contour. Program awaits setting the source contour and the line which will
represent the mirroring axis.
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Three previous functions create identical copies of the source contour and leave the original contour
unchanged.
Construct equidistant contour specified by the distance from the source contour. Program awaits
setting the source contour and the distance between the source and equidistant contours. To
create multiple equidistant contours of the same distance from the original contour, use the
Repeat button.
Construct equidistant contour specified by the bevel angle. Program awaits setting the source
contour, (which must be situated in other XY plane that the new contour) and then the bevel
angle. To create multiple contours of the same bevel angle, use the Repeat button.
Construction of an equidistant contour with a specified bevel angle. The program awaits setting
the source contour first (which must be positioned in a different XY plane than the new contour).
Then it's required to set the bevel angle. For creation of multiple contours of the same bevel
angle, the Repeat button can be used.

4.2.7 Dimensioning toolbar
Contains Kovoprog's dimensioning functions.
The same functions can be found in the Edit >
Dimensioning.

Construct straight dimension. Program awaits setting the contour line (which will be dimensioned
automatically), or setting the horizontal line (from where the new line will begin), or specifying
the first and the last points' position. The dimension placement must be specified in all cases.
Construct vertical dimension. Program awaits setting the contour line (which will be dimensioned
automatically), or setting the vertical line (from where the new line will begin), or specifying the
first and the last points' position. The dimension placement must be specified in all cases.
Construct random dimension. Program awaits setting the contour line (which will be dimensioned
automatically), or setting the random line (from where the new line will begin), or specifying the
first and the last points' position. The dimension placement must be specified in all cases.
Construct angle dimension. Program awaits setting two contour lines, which include the angle to
be dimensioned. Then the dimension and description positions must be specified.
Construct two points' diameter. Program awaits setting the contour circle (which will be
dimensioned automatically), or both ending points' position. Then the dimension position must be
specified.
Construct circle diameter dimension. Program awaits setting the contour circle and then the
dimension direction and description position.
Construct workpiece radius dimension. Program awaits setting the contour arc and then the
dimension direction and description position.
When creating dimension with description on the center, the Ctrl key can be on when specifying the
dimension position. The program will not request placing the description (it will be placed on the
center).
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4.2.8 Modifications toolbar
Includes functions for modifying/deleting objects
and planes in Kovoprog. The same functions can
be found in the Edit menu.

Modify existing objects and planes. First, the program awaits setting the object to be modified.
When selected, the object is colored red (in the standard color settings). The ending points of the
edges that can be modified are marked with the white rectangle. When dragged by the mouse,
the edge can be modified. The program does not allow to place the edge in a position where it
would be crossing another edge, but it offers the last possible not crossing position. The edge
where both ending points can be modified can be removed by placing both ending points on the
adjacent edges. The object description can also be changed in this mode.
Delete existing objects. First, the program awaits setting the object to be deleted. When
selected, the object is colored red (in the standard color settings) and requests confirming the
delete operation.
Two previous functions work with any existing element. Following functions can be applied on contours
only.
Add new points to an existing contour. First, the program awaits the contour to be set. The
selected contour will be highlighted in red (in standard color settings). The places on the contour
available for point insertion are marked. When the cursor is placed on a construction geometry
element, its itersection with the selected contour will be marked. Then click to insert the point.
Divide existing contour. First, the program awaits the contour to be set. The selected contour will
be highlighted in red (in standard color settings). Possible division place is marked on the
contour. When the cursor is placed on a construction geometry element, its itersection with the
selected contour will be marked. Click to divide the contour. Also, closed contour can be changed
to open this way.
If the previous two contours are applied on a text-type contour or a contour created by
displacement/rotation/mirror/equidistant operation (one of the last six functions of the contour panel),
the program will ask to convert the selected contour to a simple type. If the function is confirmed, the
contour will be converted, if not, function will not proceed.
Convert selected contour to a simple type. Can be applied to a text-type contour or to a contour
created by the displacement/rotation/mirror/equidistant operation (one of the last six functions of
the contours panel). After this, the contour will be converted to a sequence of lines and the
original contour spline will be deleted.
Contour corner fillet. The program awaits the contour to be specified first. The selected contour
will be highlighted in red (in standard color settings) and the available corners will be marked by
the white squares. Click on one to set the fillet radius. The recently used radiuses and the allcorner fillet options are available through the arrow at the very right of the status bar. To create
multiple fillet corners of the same radius, click the Repeat button.
Places a knob to the acute angle. The process is the same as in the previous case.
Cut off the sharp corner. The result cut is perpendicular to the axis of the original corner. The cut
angle can be modified by modification of the element. The cut off creation process is the same as
in the previous two cases.
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Displace contour. First, the program awaits the contour and the displacement amount to be set.
The same operation can be done with the point matrix in the XY plane.
Rotate contour. Program awaits the contour and the rotation center and angle to be set. To
rotate multiple contours by the same center and angle, click the Repeat button. The same
operation can be done with the point matrix in the XY plane.
Mirror contour. Program awaits setting the contour and then the line which will be used as the
mirroring axis. The same works for the points pattern in XY plane.
Change contour size. Program awaits the contour to be set first. The selected contour will be
highlighted in red (in standard color settings) and the possible future shape will be displayed.
Change the size by moving the mouse or type in the value from keyboard. The reference point is
the cross-section of the left and bottom borders of the object.
Previous six functions can not be applied on a text-type contour or a contour created by
displacement/rotation/mirror/equidistant operation (one of the last six functions of the contour panel).
The
contour simplification function must be applied first. .
Any modifiication of the geometric data activates the Undo function in the Edit menu. When applied, the
modification will be taken back and the function will change to Redo. The Redo function returns the
cleared modifications back.
4.2.9 3D geometry window
Whenever it's required to program cutting in multiple axes with non-constant bevel, the geometric object,
which will be used to define the cut,
must be constructed. The 3D geometry
window is used for constructions of such
objects. The object is defined by two
two-dimensional splines. The splines
must be either both enclosed or both
open and must be positioned in planes
with different Z coordinate. At least one
edge connecting a point of the first spline
with point on the second spline must be
defined. Program can completes the rest
of the edges automatically, so that every
vertex of both splines lies on at least one
edge.
Window can display the created object in
wireframe or with transparent faces. The
view can be switched from common
axonometry to the XY plane view (with side bars and measures displayed). To rotate the view, use the
slide bars (with angles displayed) or the mouse.
The toolbar with basic window controls is located in the upper part of the vindow (as in other graphic
windows).
There can be a 2D geometry window open for each plane. The geometric elements situated in this plane
are edited in this window. The elements situated in other planes can also be displayed, but cannot be
modified. These elements can be used for construction purposes (for example, constructing lines parallel
with these).
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The toolbar in the upper part of the window is used to set the desktop properties. The selection of the
edit mode is done from the main geometry toolbar. Geometric functions are divided between two panels object panel and modifications panel.
The three axis buttons X, Y, and Z are displayed in the right part of the status bar. The column with the
current coordinate in particular axis is displayed next to each button. These buttons (unlike in the 2D
geometry window can not be edited).
The desktop in the edit window can be rotated around the Z or Y axis using the bottom and left slide
bars the edit window. The
button next to the slide bar is used to switch to XY plane projection. The
button will turn on and the X and Y coordinate axes description will be displayed instead and the slide
bars change to rulers (as in the 2D geometry window). Clicking the button will return the window to the
three-dimensional view.



The desktop can only be rotated using the mouse when the appropriate button in the
main geometry panel is on.

4.2.10 3D geometry window status toolbar
3D geometry window status settings.
Turn on/off cursor snapping to the construction geometry element intersections.
Turn on/off cursor snapping to the construction geometry circle centers.
Turn on/off cursor snapping to the construction geometry.
Turn on/off coordinates rounding.
Show/hide automatic element numbering.
Show/hide construction geometry.
Show/hide contours.
Show/hide labels and numbering.
Show/hide objects.
Set object transparency. The object displaying changes according to the slide bar
position. In the position at the very left, the object displayed in wireframe. Moving the
slidebar to right will gradually increase object faces visibility ending in opaque faces at
the very right.
Turn on/off displaying basic and help planes, slide the bar to set transparency.
4.2.11 3D geometry window main toolbar

Sets the 3D geometry window edit mode
Turn on setting the object, function from the object toolbar. If the panel is not visible at the
momment, it will appear on desktop after clicking this button.
Turn on setting the plane, function from the plane toolbar. If the panel is not visible at the
momment, it will appear on desktop after clicking this button.
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Turn on the modifications mode, function from the modifications panel. If the panel is not visible
at the momment, it will appear on desktop after clicking this button.
Turn on/off the desktop section zoom in.
Zoom out.
Set original zoom.
Turn on/off mouse-controlled desktop rotation. In this mode, hold the left mouse button to
rotate desktop, without using the slide bars. Turn button off to deactivate this mode.
4.2.12 Object toolbar
Includes the object creation functions. The same functions can be found in the Edit >
Object menu.
Construction of an object. Allows to create a new object, or to add edges to an existing
object. Program awaits selecting the base and the help contours first, which cannot be
positioned in the same XY plane, or selecting an existing object. Then the edge setting
follows: first the point on the main plane, then on the help plane and so on. The cursor
snapping to the construction geometry elements function on the window status toolbar
can be used. When setting an edge that crosses with another edge, program announces
error and the last created edge will be deleted.
Construct object automatic edges. If the object is defined by the base and help planes
and at least one edge, the program fills the rest of the edges automatically so that there
will be at least one edge coming out of every vertex of both contours. Automatic edges
(unlike the ones created by the user) are displayed by a dotted line.
Confirm object. If the object is defined by the base and the help planes and every vertex
of both contours is an ending point of at least one edge, the button is active. After
clicking it, the setting of an object is confirmed.
4.2.13 Modifications toolbar
Includes functions for modifying/deleting objects and planes in Kovoprog. The same
functions can be found in the Edit menu.
Modify existing objects and planes. First, the program awaits setting the object to be modified.
When selected, the object is colored red (in the standard color settings). The ending points of the
edges that can be modified are marked with the white rectangle. When dragged by the mouse,
the edge can be modified. The program does not allow to place the edge in a position where it
would be crossing another edge, but it offers the last possible not crossing position. The edge
where both ending points can be modified can be removed by placing both ending points on the
adjacent edges. The object description can also be changed in this mode.
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Delete existing objects. First, the program awaits setting the object to be deleted. When
selected, the object is colored red (in the standard color settings) and requests confirming the
delete operation.
•
•

A modification can not lead to the state when the object is not defined.
Any change made to the geometric data performed by a function from the modifications
toolbar activates the Undo option available from the Edit menu. Use this option to
return back to the state before the modification and the option will change to Redo,
which repeats the modification. These functions are available until further operations are
made with the geometric data.

4.2.14 Geometry import window
Unlike other geometry windows, this is a modal window. It means that it remains active until the import
is not confirmed (OK) or cancelled (Cancel). Before that, other windows are inactive. The only change
that can be made to the imported data is the user coordinates beginning setting, which is available from
the toolbar. The elements description edit field is not present.
The appearance of imported data can be changed in the right part of the window. The File frame
includes a line displaying the currently openned file name and the Select file button which opens the
DXF and IGES format import window. The layers and planes for import are selected in the Display
parameters frame.
The Displace button opens the dialog which allows to displace the imported data. The Measure button
is used to change the
imported data scale. The
Reduction button opens the
dialog in which the number of
lines of which the imported
contours are composed can
be
reduced.
When the Connect option is
checked, the program
attempts to connect lapped
lines' and arcs' ends into one
continuous contour. If there
are more elements
overlapping at one point, the
contour will remain detached.
The Across layers also
connects elements lying in
different layers. The elements
lying in different planes can
not be connected.
To confirm data import, click OK. All displayed data, regardless of layer and Z coordinate, will be loaded
into single level. The desktop size is given as a unification of existing desktop and the minimal rectangular
area containing all imported data.
To leave the window without importing any data, click Cancel.
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4.2.15 Import window status toolbar
Because this panel is the only one for the import window, it includes
the status toolbar and the geometry toolbar functions.
Turn on/off the user coordinates' beginning input mode. After a new value has been specified and
confirmed with OK, the point of coordinates X=0, Z=0 will move to a newly specified point.
Activate rounding of the coordinates.
Show/hide construction geometry.
Show/hide labels and numbering.
Turn on/off dekstop section zoom in.
Zoom out.
Set original zoom.
Open color settings dialog. In other windows, this function is availble only from the Settings >
Colors... menu.
Except the coordinates beginning settings, these functions do not affect the unimported data.
4.2.16 Displace / scale / reduce imported data

When specifying the coordinates' displacement, it's possible to choose between the absolute and relative
displacement. To displace absolutely, define the coordinates of the point which is about to be displaced
and the target coordinates. To displace relatively, just set the displacement amount in both axes. If the
user begin of coordinates has been specified before, the table is pre-filled with its coordinates.
To confirm coordinates' displacement, click OK. The Cancel button will close the dialog without any
changes. The Reset button will undo all changes.
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When importing data into Kovoprog, the scale of the data can be changed. The dialog is used to specify
the enhancement factor and the reference point, whose position remains unchanged after the
enhancement. Default point is the lower left corner of the desktop.
Confirm the scale change by the OK button or press Cancel to close the dialog (no changes will be
made). The Default button restores the original values.

Kovoprog allows to replace contours containing inadequately high number of points with simplier shapes.
Two reduction types are available: replace multiple continuous lines with one line or with arc. It's possible
to choose any or both options by checking the appropriate dialog field. The limit reduction value (maximal
difference between the new and the old contour) must be set for both reduction types. Also the minimal
arc radius is required for the arc type reduction.
Click OK to confirm contour reduction or click Cancel to close dialog with no changes. Default button
restores original dialog values.
4.2.17 Supported format DXF
Kovoprog supports the import of the ASCII DXF format files up to version 14. Composing entities to
blocks and views is not allowed.
Kovoprog allows to import following entities:
Arc in the XZ plane.
Circle in the XZ plane.
Line in the XZ plane.
Point.
Open/closed contour composed of lines or arcs in one XZ plane. The contour composed
of curves is not supported.
LWPOLYLINE Open/closed contour composed of lines or arcs in one XZ plane.
The spline in the XZ plane is replaced with the sequence of lines. The replacement
SPLINE
accuracy (and therefore the number of lines) is specified when importing the spline.
ARC
CIRCLE
LINE
POINT
POLYLINE

Other DXF entities are not supported for import into Kovoprog.
4.2.18 Supported format IGES
Kovoprog supports import of the uncompressed ASCII format IGES up to version 5.
Kovoprog allows to import the following entities:
100

Circular arc.
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102
104
106
110
112
116
124
126
308
402
404
406
408
410

Sequence of curves.
Conic section. Can be replaced with the Bezier spline, or divided into a sequence of lines or
ignored, according to the user's choice.
Sequence of lines.
Line.
Parametric spline curve.
Point.
Transformation matrix.
Rational B-spline curve. Replaced with the sequence of lines. The replacement accuracy
(and therefore the number of lines) is specified when importing the spline.
Sub-group definition.
Associativity.
Drawing.
Attribute.
Simple sub-group.
View.
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4.3 Create new technologic process
4.3.1 Technology manager
Located in the process list panel under the TECH bookmark.
Description

This field is used to fill in a short description,
which will be displayed in the open file dialog.
This simplifies the navigation in a large amount
of data.
The
button opens the description edit
window, when more than one line description is
required. Multiple lines description is used by
some NC program input post processors.

Machine

This field is used to specify the machine the NC
program will be compiled for. The machine is
selected from the list which appears after
clicking on the field.
If there is only one post processor in the
installation, the field is filled in automatically.
The
button opens the post processor
configuration parameters dialog. These
parameters influence the NC program creation
process. The number and the type of the
parameters depend on the selected post
processor. However, some post processors do
not support this function.
macros manager buttons panel with the
technology manager essential functions.
The graphic machining process manager,
which is used to create, edit anad verify the
machining process.

The Machining process is a sequence of lines, including:
•

tool lines:

•

technologic operations:

•

technologic functions:

•

technologic macros:

•

partprogram:

•

repeat, rotation and displacement application lines:

Machining process creation:
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1. Click on a particular button in the panel.
2. Place the cursor in the manager frame, the cursor will change its appearance:
3. When transferring items into the process list, the target destination is marked with arrows:
before

behind

into

When transferring into the item with combining ability (tool item, move, repeat), it's possible to
point at this item, so the arrow marks the insertion and the item is inserted into the marked item
on the last place.



The mouse cursor position is very important when placing items, the action depends on
both horizontal and vertical positions and must be tried properly.

1. After the proper placement was found, a new item is inserted by double-clicking the left mouse
button.
2. Then the edit line content dialog will appear.
Machining process line content:
Icon that represents the line
This icon can change when the line properties are changed. For example, the roughing
operation icon also differs according to the roughing operation type.
Contouring operation line with a bevelled hole cut flag on left end.
A brief line description.
Every line can contain a commentary. There are two ways how to insert commentary:
•
•

Click the right mouse button on the particular item and select the Edit commentary
option from the context menu.
Double-clicking on the particular item after the line text, where the commentary will
be displayed.

Tool and application lines:
These lines have the ability to combine other lines. The or
end. Click on these buttons to show / hide combined lines.

buttons are displayed on their left

Lines with special status:
Excluded line
Every line can be put out of effect using the
button. The excluded line is marked with a
symbol, its text is written in grey and when a new process list is created, the line is skipped. If
a tool or application line is excluded, all combined lines are excluded too. The mark is cleared
away by turning the button off.
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Ending line
The creation of a machining process can be stopped on any line using this
button. The
marked line and all lines beyond are written in grey and are not processed. The mark by turning
the button off.
Both symbols can also be chosen from the context menu which will open after clicking right mouse button
in the manager.
Machining process modifications:
•

edit line content - using this

button or double-clicking on the line.

modifying a technologic operation line with 2D / 4D contouring cut, erosion cut, collar, wire
displacement or linear cut opens the edit operation window
modifying an application line a technologic function line opens the parameters input dialog for the
parameter settings (except the
stop function).
modifying a tool line opens the tool parameters settings dialog.
•

delete line. When confirmed, the deleted line can not be restored back. If the deleted line was
a tool or an application line, all lines combined within were also deleted.

•

move line:
Drag and move the line with a mouse. Placement rules are the same as when placing a new line, the
location is marked with an arrow. Release the mouse button over a desired location. If the moved line
was a tool or application line, all lines combined within were also moved.

•

copy line:
This is done the same way as moving the line, only with the Ctrl key pressed.

•

multiple lines selection:
To add line into selection, click on the line with the Ctrl key pressed. Doing this again will de-select
the line.
To add a sequence of lines, click on the first (or the last) one, then click the last (first) one with the
Shift key pressed. The line selection may only include lines on the same level. For example, only tool
lines, or only the lines combined under the same tool.

•

multiple lines manipulation:
If there are multiple lines selected, they can also be deleted, moved or copied using the methods
mentioned above.

Machining process verification
•

The machining process manager allows to display the generated tool traces for any line. To display
the traces, select the line and click the
button. This opens the simulation window. If an operation
line is selected, the simulation window displays this operation's traces only. If an application line is
selected, all combined operations traces will be displayed. If the very first line is selected, the entire
process' traces will be displayed.

•

The fixing button
is located in the simulation window. It influences the window status according to
the technologic process manager.
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•

In addition to the graphical simulation of the tool traces, also the numeric values are available after
clicking this
button. The CL data listing window always displays the selected line of the process.
The selected line must be either operation or partprogram line. If not, the window is empty.

4.3.2 Technology manager toolbar
Edit multiple lines description
This button opens the window for editing a multiple
lines description. Multiple lines description is used by
some postprocessors for transferring large notes to
NC program. After clicking the button, the process list
description edit window will appear on screen.

Postprocessor parameters settings
This button opens the dialog, where some of the postprocessor parameters which influence the
NC program creation process are set. The number and type of parameters depend on the used
postprocessor. Some postprocessors do not support this function.
Insert tool
Activates the tool line insertion mode:
•
•

defines the diameter of the used wire
allows to set additional parameters in T, S, D, P
order. The usage of these varies for the different
machine types.

After inserting the item to the process list, the tool
parameters settings dialog will appear on screen.
Insert two-axial contouring cut
Activates the 2D contouring cut insertion to the process list. The button can be used when these
conditions are met:
•
•

There is a tool line inserted in the process list
There is at least one planar spline created in any plane, or an object exists.

After inserting the item to the process list, the operation windows opens on desktop and the
contour toolbar is displayed at the upper right part of the window.
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Insert four-axial contouring cut
Activates the 4D contouring cut insertion to the process list. The button can be used when these
conditions are met:
•
•

There is a tool line inserted in the process list
There is at least one planar spline created in any plane, or an object exists.

After inserting the item to the process list, the operation windows opens on desktop and the
contour toolbar is displayed at the upper right part of the window.
Insert collar cutting
Activates the collar cut insertion to the process list mode.
The button can be used when these conditions are met:
•
•

There is a tool line inserted in the process list
There is at least one planar spline created in any plane, or an object exists.

After inserting the item to the process list, the operation windows opens on desktop and the
contour toolbar is displayed at the upper right part of the window.
Insert erosion cut
Activates the erosion cut insertion to the process list mode. The button can be used when these
conditions are met:
•
•

There is a tool line inserted in the process list
There is at least one planar spline created in any plane, or an object exists.

After inserting the item to the process list, the operation windows opens on desktop and the
contour toolbar is displayed at the upper right part of the window.
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Insert wire displacement
Activates the wire displacement (wire disconnection, then connection again elsewhere) item
insertion mode. The button can be used when there's at least one tool line inserted in the process
list.
After inserting the item to the process list, the operation windows opens on desktop and the
contour toolbar is displayed at the upper right part of the window.
Insert linear cut
Activates the linear cut (whose point is selected by the user using the mouse) insertion mode. The
current position of the tool is marked by the cross.
After inserting the item to the process list, the operation windows opens on desktop and the
contour toolbar is displayed at the upper right part of the window.
The button can be used when there's at least one tool line inserted in the process list.
Insert M-function
Activates the M-function insertion to the process list mode. When the item is inserted, the dialog
to specify the M-function number opens.
The button can be used when there's at least one tool line inserted in the process list.
Insert L-function
Activates the L-function insertion to the process list mode. When the item is inserted, the dialog to
specify the M-function number opens.
The button can be used when there's at least one tool line inserted in the process list.
Insert G-function
Activates the G-function insertion to the process list mode. When the item is inserted, the dialog
to specify the M-function number opens.
The button can be used when there's at least one tool line inserted in the process list.
Insert machine cycle
Activates the machine cycle insertion to the process list mode. This item is used to execute some
machines' special functions, which do not have a common equivalent in the technologic processor.
The possibilities of this item's application can be found in the documentation for the particular
generator. When the item is inserted, the necessary parameters specification dialog opens.
The button can be used when there's at least one tool line inserted in the process list.
Insert program stop
Activates the mode for inserting a program-stopping item.
The button can be used, if there is a tool line inserted in the process list.
Insert correction change
Activates the mode for inseting the tool correction change. When the item is inserted, a dialog will
open, in which the tool correction number must be specified.
The button can be used when there's at least one tool line inserted in the process list.
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Insert delay
Activates the mode for time delay insertion to the process list. When the item is inserted, a dialog
will open in which the delay amount must be specified.
The button can be used, if there is a tool line inserted in the process list.
Insert macro
Activates the mode for inserting the macro to the process list. After clicking the button, the panel
with all libraries' icons will be displayed. These libraries contain technologic macros. The panel
with all libraries containing technologic macros will appear after clicking this button.
Libraries panel example
See the macros manager to learn how to create macro libraries and work with them.
Represents the Special shapes cutting. The library is delivered with the system.
Represents the Gear wheels cutting. The library is delivered with the system.
This icon represents the libraries created by the user. To learn how to create and work
with macro libraries, see the macros manager.
When the library and the macro are selected (by clicking on the macro library) and the macro is
inserted to the process list, the program awaits setting the macro parameters in the table, which
will appear at the desktop. When the parameters are set, the component geometry (contour) and
the component machining process will be created by the macro.
Insert partprogram
Activates the partprogram insertion to the process list mode. This item enables to apply the textoriented programming of the version 2.x style in the process list and therefore use its extensive
possibilities.
When the item is inserted to the process list, click on the item in the technology manager to open
the partprogram window on the desktop. After the window is filled in, the partprogram toolbar
(which is used for work with the partprogram) will be displayed in the upper right corner.
The “Open PP” button can be used to insert existing partprograms which are saved in the
memory, or to write a new partprogram using a text editor. The geometric routines describing the
component shape and the technologic routines describing the machining process can be inserted.
Insert repeat
Activates the repeat insertion mode. This item allows to repeat a process list part mlultiple times.
When the item is inserted, the dialog to specify the necessary parameters will open.
The button can be used when there's at least one tool line inserted in the process list.
Insert displacement and rotation
Activates the displacement insertion mode. This item enables to move the tool traces in a process
list part by a specified offset. When the item's inserted, the dialog will open to set the requested
parameters.
The button can be used when there's at least one tool line inserted in the process list.
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Edit item
Click on this item to edit the currently selected item of the process list, to edit the data defining
this operation. If there are multiple items selected, the last one will be modified.
The modification type depends on the type of the item. It can be done by filling in particular fields
in a dialog, or in a specialised graphical operations editor for complex operations.
The modification can be also called by double-clicking on an item in the process list.
If there is a
function on in the edit mode , there can be multiple edit windows open at a time
for more process list items. If this function is turned off, only the window of the currently edited
operation will be displayed. This will always be replaced by a new edit window. It is the same
when creating a new process list item or viewing existing process list items. To browse process list
items, click EDIT on one item, then move along the process list.
Delete selected items
This button is used to remove the selected item(s) from process list. A confirmation dialog will be
displayed before deleting every single item.
Display simulation
Click this button to open the simulation window in okna simulace the graphical tool motion
simulation mode. According to the selected process item, the entire process, or only one part
(tool or another combining item), or only one single operation traces will be displayed.
Clicking on the icon multiple times will open more simulation windows for the same operation.
After clicking the button, the simulation toolbar will appear in the upper right part of the manager.
Display CL data
This button is used to open/close the window with the numeric values of the tool traces (the so
called CL data) for the selected item. Close this window by clicking on this button again.
The CL data window can be only one at a time and its content changes according to the item
selected in the process list.
The button can be used when there is an item selected in the process list which contains CL data.
Set end of processing
The STOP button halts the processing on the selected item and skips the rest of the process. It is
an equivalent to the END command in partprogram. To deactivate, click the button again.
Exclude item from processing
This button marks the selected item to be skipped and the process to be continued from the next
item. If the selected item combines other items (for example a tool line), all items included within
will be skipped. It is an equivalent to the ( ! ) command in partprogram. To deactivate, click the
button again.
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4.3.3 Operation window

The operation window is used to create and edit the following operations in the process list:
2D contouring cut
4D contouring cut
Collar cutting
Erosion cut
Wire displacement
Linear cut
There are two Operation window modes: edit mode and simulation mode. To switch between
modes, click the
button. In the edit mode, the window allows to set or edit operation parameters. In
simulation mode, the window displays tool motion traces in two-dimensional view.



Clicking the



To switch between the simulation and edit mode, use the "/" slash key on numeric keyboard part.

and

buttons in the simulation toolbar will switch the window automatically to

the simulation mode.

The toolbar in the upper part of the window changes according to the window mode:
operation window toolbar status in edit mode
operation window toolbar status in simulation mode.
The buttons from the main toolbar in the upper part of the program window are used for editing most
operations. The functions of these buttons depend on the actual operation.
The lower part of the window includes the simulation toolbar which is used to control the wire motions
simulation.
The Status bar on the lower window border changes its content according to the window mode:
In edit mode (from
left):
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•
•
•

edited variable description
edit columns for setting numeric values
for some operations, it's possible to change work planes using the arrow in the lower right window
corner
In simulation
mode (from left):

•
•
•

operation type
coordinates of the wire in work plane
name of the work plane

4.3.4 Simulation window

The tool traces simulation displays the wire motion as it was calculated by the program. The trace of the
wire's intersections with the main and the help planes are displayed (even if the motion was programmed
in other planes). The buttons in the lower part of the window are used to control the running of the
simulation and its speed. Viewport setting is done the same as in the 3D geometry window. The view can
be switched to the XY plane (to display the rulers) or rotated freely by mouse or slide bars. During the
simulation, the name of the item the simulated trace belongs to and the coordinates of the wire in the
main plane are displayed in the lower part of the window. Use the button in the upper toolbar to
show/hide the coordinates panel which displays current coordinates of the wire's end in the main and the
help planes.
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If only the two-axial cutting is programmed (no help plane is specified), the simulation is displayed
in two-dimensional view only.

4.3.5 2D contouring cut
To insert the 2D contouring cut, click the
button in the technology
bookmark of the process list or in the operation window. If there is only one
contour in the geometry, the Kovoprog places the 2D contouring cut on it
automatically. If there are multiple contours, click on the contour upon which
the cut is to be placed. 2D contouring cut must also be placed on the
object contours. Then the beginning of the operation can be adjusted using
the mouse, the correction can be set using the arrow. Then the approach and
deproach must be specified using the buttons from the toolbar. The
parameters of the cut - unfinished move length, move over and absolute
trace + its length, eventually the trace from point to point (as in our case).
Wire bevel can be specified in degrees, for opposite bevel set the minus
sign. There are three bevel types to choose from: standard bevel, ISO
bevel and fixed bevel with angle specified in the Y axis. There is also the
possibility of setting the approach and deproach M-function, if it's necessary.
Some (more recent) postprocessors are programmed to insert these
functions automatically. It's required to click the
button after every change to recalculate new
values and changed. When the auto option is checked, the program will perform recalculations
automatically in a specified time interval.
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There are two Operation window modes: edit mode and simulation mode. To switch between
modes, click the
button. In the edit mode, the window allows to set or edit operation parameters. In
simulation mode, the window displays tool motion traces in two-dimensional view.
•

Clicking the
and
buttons in the simulation toolbar will switch the window
automatically to the simulation mode.

•

To switch between the simulation and edit mode, use the "/" slash key on numeric
keyboard part.

The toolbar in the upper part of the window changes according to the window mode:
operation window toolbar status in edit mode
operation window toolbar status in simulation mode
The buttons from the main toolbar in the upper part of the program window are used for editing most
operations. The functions of these buttons depend on the actual operation.
The lower part of the window includes the simulation toolbar which is used to control the wire motions
simulation.
The Status bar on the lower window border changes its content according to the window mode:
In edit mode
(from left):
•
•
•

edited variable description
edit columns for setting numeric values
for some operations, it's possible to change work planes using the arrow in the lower right
window corner

In simulation
mode (from left):
•
•
•

operation type
coordinates of the wire in work plane
name of the work plane

4.3.6 4D contouring cut
To insert the 4D contouring cut, click the
button in the technology bookmark of the process list or
in the operation window. If there is only one contour in the geometry, the Kovoprog places the 4D
contouring cut on it automatically. If there are multiple contours, click on the contour upon which the cut
is to be placed. 4D contouring cut must also be placed on the object contours. Then the beginning of
the operation can be adjusted using the mouse, the correction can be set using the arrow. Then the
approach and deproach must be specified using the buttons from the toolbar. The parameters of the cut unfinished move length, move over and absolute trace + its length, eventually the trace from point to
point (as in our case). Wire bevel can be specified in degrees, for opposite bevel set the minus sign.
There are three bevel types to choose from: standard bevel, ISO bevel and fixed bevel with angle
specified in the Y axis. There is also the possibility of setting the approach and deproach M-function, if it's
necessary. Some (more recent) postprocessors are programmed to insert these functions automatically.
It's required to click the
button after every change to recalculate new values and changed. When
the auto option is checked, the program will perform recalculations automatically in a specified time
interval.
Kovoprog – Wire cutting – User's guide - page 70

Operation window can be of the same statuses as for the 2D contouring cut
4.3.7 Collar cutting
Collar cutting can be inserted using the
button in the technology bookmark of the process list or in
the operation window. If there is only one contour in geometry, Kovoprog places the contouring cut for
collar on it automatically. If there are multiple contours in geometry, the one which we want the cut to be
placed on must be selected by the mouse. Collar cutting is done by one angled cut and the following
straight cut. When the operation is inserted, the beginning of the operation can be adjusted by the
mouse. Use the arrow to set correction. It's also
necessary to place approach and deproach by the
buttons from the toolbar. The cut parameters can
be adjusted in the operation parameters dialog
- unfinished move length, move over and absolute
trace + its length, eventually the trace from point
to point (as in our case). Next, the Collar shape is
about to be defined - upper, lower or both bevels.
There are two bevel types: standard bevel and
ISO bevel. Wire bevel for angled cut is specified
in degrees, for oppposite bevel set the minus sign.
Also, the tool parameters of the cut for 2D cut
can be changed in the dialog. In case of using both
bevels also for the upper bevel. Example of the new parameters for 2D cut window for Agie 100
postprocessor:
This function is not programmed in all postprocessors, but it's not a problem to add it on customer's
request.
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There is also the possibility of setting the approach and deproach M-function, if
it's necessary. Some (more recent) postprocessors are programmed to insert
these functions automatically. It's required to click the
button after
every change to recalculate new values and changed. When the auto option is
checked, the program will perform recalculations automatically in a specified
time interval.
There are two Operation window modes: edit mode and simulation mode.
To switch between modes, click the
button. In the edit mode, the window
allows to set or edit operation parameters. In simulation mode, the window
displays tool motion traces in two-dimensional view.
4.3.8 Linear cut and wire displacement
Wire displacement can be inserted by the
button in the process list technology bookmark or in the
operation window, as other technologic operations. Insertion is done under the tool or under previous
operations. The wire can be displaced from coordinates where the previous operation ended, eventually
from the starting point. After inserting the displacement into the process list, use the mouse to set the
displacement target point. The exact coordinates can be set from keyboard. The wire cutoff M-function
and the fastmove trace will appear in the NC output. If another operation follows, it's necessary to thread
the wire again.
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To insert linear cut, click the
button
in the technology bookmark of the process
list or in the operation window as the
previous operation. Linear cut is usually
inserted after inserting the wire
displacement. When the linear cut is
inserted, set the coordinates of the linear
cut ending point using the mouse or
keyboard. The starting point of the cut is
given by the ending point of the previous
operation (for example the displacement).
The linear trace will then normally appear
in NC output as circular interpolation (G1).
Operation window can be of the same
statuses as for the 2D contouring cut.

4.3.9 Erosion (wasteless) cut
The wasteless erosion cut can be inserted using the
button in the process list bookmark and in
the operation window. If there is only one contour in the geometry, the Kovoprog places the erosion cut
on it automatically. If there are multiple contours, click on the contour upon which the cut is to be placed.
Then adjust the beginning of the operation using the mouse and set the arrow which marks the
machining direction. To change cutting parameters, set increment, cut-in radius and wire overlap, use the
operation parameters dialog. It's possible to set M-function before and after the cut. Inserting these
functions must be considered in postprocessor. It's necessary to click the
button after every
change to recalculate new values and changes. When the auto option is set, the program will be
recalculating these values automatically in a specified time interval.
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After the erosion cut, also the 2D contouring cut is inserted on the contour in technology.
Operation window can be of the same statuses as for the 2D contouring cut.
4.3.10 Tool approach to contouring cut menu
Appears on the screen after clicking the
button in the contouring operation panel.
Allows to create various cut approach types, to delete the approach, define or delete Mfunction called at the beggining of the approach (for example wire threading). Note: New
postprocessors generate wire threading automatically before the first cutting trace after
the fast move. In older postprocessors, generating the threading M-function could be
influenced by the setting of the approach.
Perpendicular approach to cut from specified distance from the contour
After clicking the button, the request for setting the approach length will appear in the status bar. The
approach is created from the starting point of the contour and its length is determined by the position
of the mouse cursor position (its distance from contour), or set from keyboard.
Perpendicular approach to cut from point
After clicking the button, the request for setting the starting point's position will appear in the status
bar. The coordinates of the starting point are determined by the mouse cursor position, or set from
keyboard. The starting point of the contour automatically moves to the point which is the perpendicular
projection of the starting point of the approach.
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Approach to contour from specified point
After clicking the button, the request for setting the starting point's position will appear in the status
bar.The coordinates of the starting point are determined by the mouse cursor position, or set from
keyboard. The approach is defined by trace from the specified point to starting point of the approach.
Perpendicular approach from distance
After clicking the button, the request for setting the approach
length will appear in the status bar. The approach is created from
the starting point of the contour and its length is determined by
the position of the mouse cursor position (its distance from
contour), or set from keyboard. The approach is defined by the
perpendicular trace leading from the specified point to the contour.
The transition between this trace and the contour is a circular
tangential trace. Its radius is automatically set to two times the
radius of the wire. Then, of course, it's possible to change it to any
acceptable value in the radius setting dialog.

Tangential approach from point
After clicking the button, the request for setting the starting point's position will appear in the status
bar.The coordinates of the starting point are determined by the mouse cursor position, or set from
keyboard. The approach is defined by the perpendicular trace leading from the specified point to the
contour. The transition between this trace and the contour is a circular tangential trace. Its radius is
automatically set to two times the radius of the wire. Then, of course, it's possible to change it to any
acceptable value in the radius setting dialog.
Starting point of the contour automatically moves to the point where the tangential arc connects to the
contour.
Tangential approach from distance
After clicking the button, the request for setting the approach length will appear in the status bar. The
approach is created from the starting point of the contour and its length is determined by the position
of the mouse cursor position (its distance from contour), or set from keyboard. The approach leads
from the point located perpendicular to the starting point of the contour in a specified distance. The
approach consists of a linear section which tangentially connects to an arc which tangentially transits
into the contour in the specified starting point. The radius of the tangential transition is automatically
set to two times the radius of the wire. Then, of course, it's possible to change it to any acceptable
value in the radius setting dialog.

Tangential approach from point
After clicking the button, the request for setting the starting point's position will appear in the status
bar.The coordinates of the starting point are determined by the mouse cursor position, or set from
keyboard. The approach leads from the specified point. It consists of a linear section which tangentially
connects to the circular arc which tangentially transits into the contour at the point which is the
perpendicular projection of starting point of approach. The radius of the tangential transition is
automatically set to two times the radius of the wire. Then, of course, it's possible to change it to any
acceptable value in the radius setting dialog.
Starting point of the contour will automatically move to the point which is the perpendicular projection
of starting point of the approach.
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Tangential approach from random point
After clicking the button, the request for setting the starting point's position will appear in the status
bar.The coordinates of the starting point are determined by the mouse cursor position, or set from
keyboard. The approach leads from the specified point. It consists of a linear section, which tangentially
connects to the circular arc that tangentially transits into the contour at its starting point. The radius of
the tangential transition is automatically set to two times the radius of the wire. Then, of course, it's
possible to change it to any acceptable value in the radius setting dialog.

Delete approach
Remove an existing approach.
Set M-function
Open the sdialog which allows setting the M-function number,
eventually the delay in seconds.

Delete M-function
Remove existing M function.

4.3.11 Tool deproach from cut menu
Appears on the screen after clicking the
button in the contouring operation panel.
Allows to create various types of deproach from the cut, to delete deproach, define or delete M-function
called at the end of the cut (for example the wire disconnection). Note: New postprocessors generate the
wire disconnection automatically before the first fast move trace. In older postprocessors, the disconnect
M-function generation could be affected by the deproach settings.
After clicking the button in the status bar, the request for setting the distance from contour or setting the
starting point's coordinates will appear. When the cursor is moved into the window desktop, the cursor
distance value or the request for setting the X and Y of the starting point will be displayed at the lower
right corner.
For tangential deproach from contour, the deproach radius of two times the wire radius is selected by the
system. This value can be changed: head the mouse cursor over the approach radius dimension value so
that the table symbol is displayed over the dimension. After clicking the mouse button, the
approach/deproach radius setting dialog will open. The approach/deproach radius size can be set either
as amultiple of the wire radius, or as a numeric value.
Move wire to starting point
Deproach to starting point
Perpendicular deproach
Tangential deproach to distance
Tangential deproach to distance
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Tangential deproach to starting point
Deproach to starting point with reverse gear
Tangential deproach to specified point
Deproach in perpendicular plane
Delete deproach
Set M-function
Delete M-function

4.4 NC program
4.4.1 NC program window
NC program is generated by the information included in the process list after clicking on the button in the
main toolbar. Before the NC program creation can start, the machine must be specified in the technology
manager. After clicking on the button, NC program window will open on the desktop and the NC program
toolbar will appear at the top.
During the NC program creation
process, the interruption dialog
will be displayed at left of the
status bar. The numbers of the
generated NC program blocks are
also displayed in the status bar.
The process list name is
displayed in the window caption.
The numbers of the generated
blocks are displayed in the left
part of the status bar during the
NC program generation process.
When finished, the lengths of the
tool in the main and the help
plane are displayed there.
The NC program window is a text
editor which allows NC program
modifications.
The NC program column and the
number of the line where the cursor is located are displayed at the right of the status bar. Other editor
functions are: send NC program to output device or save/load NC program.
If there were any changes made, for example, the tool has been changed in the process list, the NC
program recalculation is activated automatically after opening the NC program window. The recalculation
can also be activated by clicking on the
button in the NC program toolbar.
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4.4.2 NC program input and output window
After clicking NC program input/output buttons in the
NC program toolbar, the NC program input/output
dialog will appear on the desktop. Fill in necessary
communication information in the Transfer line, Data
and Detail bookmarks.

4.4.3 NC program toolbar

Recalculate NC program. Required when changes are made to tuhe process list or the device is
changed the NC program is generated for.
The button is available only when changes were made. If it's inactive, it means that it's not
required to recalculate the NC program.
Opens the NC program block numbering
settings dialog. When the first block number
and the numbering addition are specified, the
entire NC program is automatically
recalculated.
Send the NC program to the output device. The dialog window to set the required parameters
will open on the desktop.
Load the NC program from the output device. The dialog window to set the required parameters
are set will open on the desktop.
Open the NC program from file. The Open file dialog will open, in which the source directory and
file (NC program files have the .NCP suffix) are set.
Save the NC program to a file. The Save file dialog will open, in which the target directory and
file (NC program files have the .NCP suffix) are set.
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4.5 Macros
4.5.1 Macros manager
Located in the process list panel under the MAK bookmark.
Description
This field is used to fill in a short description, which will be
displayed in the open file dialog. This simplifies the navigation in
a large amount of data.
The
button opens the description edit window, when
more than one line description is required. Multiple lines
description is used by some NC program input post processors.
Machine
This field is used to specify the machine the NC program will be
compiled for. The machine is selected from the list which
appears after clicking on the field.
If there is only one post processor in the installation, the field is
filled in automatically.
The
button opens the post processor configuration
parameters dialog. These parameters influence the NC program
creation process. The number and the type of the parameters
depend on the seected post processor. However, some post
processors do not support this function.
macros manager toolbar with the essential functions of the
technology manager

The graphic macros manager is used to create and modify macro libraries and edit the macros within.
Most important key words:
macro
macros library

Text written in the Kovoprog program, begins with the macro keyword and
ended by the endmac keyword. The system determines the macro by its name.
A special .MAC suffix format file, which contains all macros' texts.

The manager is divided into sections. The button before the section name shows/hides the section
content. If the section is empty at the momment, the buttons are not displayed. When there is a macro
called in the process list, the program looks up this macro in all sections (or libraries specified in these
sections). Sections and libraries are searched from top to bottom as they are specified in the manager. If
there are two macros of the same name, the first one found will be used.
Manager sections description:
Active macros
This section contains all macros which are currently loaded in the computer memory. For
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example, the newly created macros, macros called from the process list, or macros openned in
the macros editor.
User
Only the macros called in the currently active process list are stored in this section. The macros
list from this section will be saved as a part of the process list in a special file with the .PLD
suffix.
Generator
Section reserved for the machine-specific macros. It can contain libraries defined in the post
processor text (the post processor must not include any such library). The macros constructing
tool incoming and outgoing traces make a fine example. The section automatically contains a
library of the same name as the post processor (the .GEN file). This library must not be created,
but user can create it anytime and insert his own machine-specific macros in it.
System
During the program installation, the macro libraries delivered with the program are stored into
section. The user can add his own most frequently used libraries.
Every library included in this section can be marked as common, geometric, or technologic.
This helps integrating these libraries into the system (select the Properties option in the context
menu activated by clicking the right mouse button on the library line).

The content of “Description” and “Icon name” text fields will
be displayed in macros panel when inserting a new macro to
process list.
•

•

•

Common library macros are used (like other macros) in
the part-program text, or as a part of another macro's
text.
Geometric library macros are be called by the
button in the contour panel of the 2D graphic editor. These macros are used to construct special
geometric shapes and must be of a specific format.
Technologic library macros are called by the
button in the technology manager buttons panel.
These macros can be inserted directly into the process list.

Every library can have its own icon and description assigned. This is done in the Properties dialog for
geometric and technologic libraries. The icon will represent the library in the menu after clicking this

,

or this
button. The description will be displayed in the bubble help window after placing the mouse
button on the library icon in the menu. If there is no icon assigned to a library, it will be represented by
this
standard icon.

4.5.2 Search
The macros lookup and manipulation section. Displays the macro libraries found in the specified directory.
Directory change is done in the macro library lookup dialog which is activated by clicking the
button,
or double-clicking on the section name.
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Working with macros and macro libraries in the manager:
•

The button before the library name shows (

•

The libraries can be moved inside the section or between sections by simply dragging them with a
mouse. The library sequence (which influences the library lookup order) can also be changed using
the
and the
buttons.

•

The library can be added by dragging from the search section or pressing the

•

Library removal is done by the

) and hides (

) the macros included in the library.

button.

button.

➔ When moving the libraries between sections, or adding/removing libraries, only the related file links

are modified. The library (.MAC suffix) files on disk remain unchanged and can only be
moved/deleted directly from Windows.
Macros can be moved from one library to another by dragging them with a mouse. If also the Ctrl key is
pressed, the macro will be copied.
Create new macro.
Remove macro from the library.
Load selected macro into memory (the macro will be included in the Active macros section).
Edit macro text using macro editor.



Moving macros between libraries, or adding/removing macros causes an actual change in the
library file. For example, moving the macro from one library to another will cause the macro text to
be removed from the first library and added to the second.

4.5.3 Macros toolbar

Compile macro
The compile macro button is available only when changes were made to the macro. When
compiled, the "OK" mesage will be displayed in the status bar.
Save macro
Available only after the macro is compiled.
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4.5.4 Macros search dialog

The dialog is called from the macros manager. It allows
to define the macro libraries directory. These libraries
are then displayed in the Macros manager search section
and are available for further work in the manager.

4.5.5 Geometric macros – brief description
The geometric macros are displayed in the geometric
library toolbar. The geometric macro is used to construct
special macro-defined shapes. To be displayed in the
toolbar, the macro must have a special syntax: its icon
name must be defined and it must return a surface.
Syntax:
macro name [\'commentary'\] 'icon' (parameters) : contour
... !macro body
endmac

Parameters:
• name (string) – macro names
• commentary (string) – the help commentary which will be displayed in the partprogram editor or
as a bubble help on the macros toolbar (optional)
• icon (string) - name of the icon that will be displayed in the toolbar
• parameters - macro parameters, allows types: integer, real, symb, string, point
• contour - the geometric macro must return a surfcae

Example:
macro square \'square'\ 'ctv'(real aa\'side length'\):contour
!this makro constructs a square with the specified side length and its
center at the begin of coordinates
aa=aa/2
square=pv('aa',-aa;-aa,aa;-aa,aa;aa,-aa;aa,u)
endmac
4.5.6 Technologic macros - brief description
The technologic macro is a macro that will be displayed in the technologic library macros toolbar. The
technologic macros can be inserted directly to the process list. To be displayed on the toolbar, the macro
must have a special syntax: a defined icon name.
Syntax:
macro name [\'commentary'\] 'icon' (parameters) : contour
... !macro body
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endmac
Parameters:
• name (string) – macro names
• commentary (string) – the help commentary which will be displayed in the partprogram editor or
as a bubble help on the macros toolbar (optional)
• icon (string) - name of the icon that will be displayed in the toolbar
• parameters - macro parameters, allows types: integer, real, symb, string, point
• contour - the geometric macro must return a surface
4.5.7 Macros manager toolbar
Create new macro
The macro window will open on desktop after clicking on this button. The new macro can be
written in this window. A toolbar with two buttons: translate macro and load macro will appear at
the top. After writing and compiling, the macro can be loaded: it will be stored in the previously
selected macro library and also to the "Active macros" item.
The button is active if a macro library is selected in the User or System items of the macros
manager panel. This is done by clicking on the icon or the library name.
Activate macro
The button is active after a macro is selected (by clicking on the icon or the macro name) from
any library in the System or User items. After clicking on the button, the name of the selected
macro will be displayed in the Acive macros item.
It's also possible to activate the macro by double-clicking on a macro in any library.
Edit macro
This button allows to edit the macro. The macro window will appear on the desktop after clicking
the button. The which was selected in the macros manager library will be displayed in the
window.
It's also possible to open the window with the macro we want to edit by double-clicking on a
macro icon in any macros library.
Delete macro
This button is available only after selecting a macro in any of the Active macros, User or
System libraries. The selected macro will be deleted after clicking the button. The macro will only
be deleted in the macros manager, the file in the libraries directory containing the macro will
remain.
Save macro
This button calls the save macro function after it's edited and translated. It's only available in the
Active macros item after selecting the macro we want to be saved. The "Save macro" button in
the toolbar has the same function.
Add library
The button is available only after selecting the User or System item. After clicking the button,
the window with the Search directory will open on desktop. When a library is selected and
confirmed by clicking on Open, the library name is inserted into an item.
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Remove library
The button is only available after a macro library is selected in the User or System item. Click on
the button to remove the selected library.
Move library up
Allows to move the selected macro library upwards. The button is active after the User or
System item is selected and if there at least two macro libraries in this item.
Move library down
Allows to move the selected macro library upwards. The button is active after the User or
System item is selected and if there at least two macro libraries in this item.
Search library
Allows to search and browse library directories. After clicking this button, the window with
directories will appear on the desktop. The last searched directory will be displayed in the Search
item.

4.5.8 Supplied library - “Gear wheel profiles”
This library is delivered with the system. It's contained in the OZKOLA.MAC file. It includes six
technologic macros for gear wheels cutting:
Cogged comb - OzHrebG macro
Macro creates a contour according to the specified parameters, which contains the cogged comb
of the trapesoid shape. This cogs shape matches the evolvent gear wheels cogs. For the cogged
comb (number of cogs: "infinite"), evolvent sides degenerate into lines. The angle included by
the vertical line and the side of the cog equals the meshing angle. The most frequently used
meshing angle is 20°.
Gear wheel - OzKoloG macro
Macro creates a gear wheel contour with evolvent cogs. Unit correction ( x ) is a value usually set
on the wheel drawing, where the total correction equals x*m, m being the module. If there is a
zero added behind the value of the head circle radius, macro calculates its diameter as:
Dh = m*z + 2*m + 2*x*m,
where z is the number of cogs. Please note that the diameter of the head circle can be lesser
than the one calculated this way. Usually it's tolerated to be lesser than zero and also, lowering
the turret can be done to eliminate interference with con-wheel gear (if there was a V-correction
applied on the gear set).
So, if the turret diameter is dimensioned, set value according to the drawing and mind also the
tolerance. If the foot circle value is set to zero, macro calculates its diameter as:
Dp = m*z – 2.5*m + 2*x*m.
Foot circle diameter usually isn't dimensioned, so zero value can be set. Turret will is maximally
0.25*m. This macro sets the contour almost identical to the input. Every evolvent of the tooth
side is replaced by few circular arcs so that the offset is maximally a few ten thousandths of a
milimeter, which is minimally one rank lower than the accuracy of the machine.
One of the input vlaues is the unit correction. Notify that a gear contour without side will is
usually created by this macro. Side will can be added by lowering the correction or setting
machine offset. If there is an extent across cogs including tolerance set in the drawing, it's better
to use the OzKolPG macro. If the extent is set across rollers, use the OzkolVG macro.
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Gear wheel across cogs - OzKolPG macro
This macro is almost identical to the OzKoloG macro. The unit correction value is calculated
from the number of cogs (the extent leads across) and the extent value. It's suggested to include
tolerance in the specified extent across cogs (for example the average tolerance value). So the
unit value calculated in the macro will be lesser than the correction value specified in the
drawing. If the value of extent across cogs does not match the possible gear, macro reports an
error. Otherwise, everything written in paragraph 2 is valid.
Gear wheel across rollers - OzKolVG macro
Almost everything written in paragraph 3 is also valid for this macro. Roller diameter and extent
across rollers is to be set here. Again, it's suggested to include tolerance in the specified value.
Everytime the number of cogs is odd, 2 cogs are set as tolerance.
Inner gear wheel - VOzKoloG macro
The macro creats an inner gear wheel contour by the specified parameters. Positive correction
means shifting profile away from the axis - make the cog thinner. Unlike in paragraph 2, if the
zero value is set as the turret circle diameter, its diameter will be calculated as:
Dh = m*z –2*m + 2*x*m. Usually it's tolerated to be lesser than zero and also, lowering the
turret can be done to eliminate interference with con-wheel gear (if there was a V-correction
applied on the gear set).
So, if the turret diameter is dimensioned, set value according to the drawing and mind also the
tolerance. If the foot circle value is set to zero, macro calculates its diameter as:
Dp = m*z – 2.5*m + 2*x*m. Foot circle diameter usually isn't dimensioned, so zero value can
be set. Turret will is maximally 0.25*m. This macro sets the contour almost identical to the
input. Every evolvent of the tooth side is replaced by few circular arcs so that the offset is
maximally a few ten thousandths of a milimeter, which is minimally one rank lower than the
accuracy of the machine.
One of the input vlaues is the unit correction. Notify that a gear contour without side will is
usually created by this macro. Side will can be added by lowering the correction or setting
machine offset. If there is an extent across cogs including tolerance set in the drawing, it's better
to use the OzKolPG macro. If the extent is set across rollers, use the VOzkolVG macro.
Inner gear wheel across cogs - VOzKoVG macro
This macro is almost identical to the VOzKoloG macro. Unit correction value is calculated from
roller diameter and extent across rollers. It's suggested to include tolerance in the specified value
(for example the average tolerance value). So the unit value calculated in the macro will be
lesser than the correction value specified in the drawing. If the value of extent across cogs does
not match the possible gear, macro reports an error. Otherwise, everything written in paragraph
5 is valid.
4.5.9 Supplied library “Cutting gear wheel shapes”
This library is delivered with the system. It's contained in the OZKOLA.MAC file. It includes six
technologic macros for gear wheels cutting:
Conic gear wheel
Gear wheel
Gear wheel across teeth
Gear wheel across rollers
Inner gear wheel
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Inner gear wheel across rollers
4.5.10 Supplied technologic macros library "Cutting special shapes"
This library is delivered with the system. It's contained in the MAKRA3.MAC file. It includes six
technologic macros for gear wheels cutting:
Gear pole cutting
Gear wheel cutting
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